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Reissued:05-Au9-10
Model: GlobalScan NX Date: 27-Nov-08 No.: RD420006a I
RTB reissue:

e Table listing target MFP models and supported VM versions.
e Remote Updating Procedure was corrected.

Subject: GlobalScan NX (L) Lapnet edition Installation Guide |Prepared by: T.Nihei
From: 1st Overseas Tech Support Sec., 1st PQM Dept.

Classification: |[L] Troubleshooting [] Part information [] Action required
] Mechanical [] Electrical [] Service manual revision
[] Paper path [] Transmit/receive [] Retrofit information
[] Product Safety X Other ( ) X Tier 2

This RTB has been issued to announce the GlobalScan NX (L) version 1.4 (Lapnet
edition) Installation Guide release information.

GlobalScan NX (L) Lapnet edition is a copy-protected VM card containing a pre-installed
copy of the GlobalScan NX SDK application. When the VM card is inserted into a MFP,
Java VM and the GlobalScan NX (L) SDK application will be installed and started-up
automatically.



PAGE: 2/12

July, 2010
Subject to change
Ricoh Company LTD



PAGE: 3/12

Target MFP models and supported VM versions.

For each MFP model, make sure to install the following or newer version.

Model Name VM Ver.
B222/B224 V2.15
B230/B237 V2.15
B246/B248/B249 V2.15
D052/D053/D054 V2.15
D009/D012 V4.20
D011/D013 V4.20
D014/D015 V4.20
D017/D019 V4.20
D018/D020 V4.20
D046/D049 (see [NOTE]) | V4.22
D084/D085 V4.20
D091/D092 V4.20
D023/D025 V4.20
D027/D029 V4.20
D037/D038/D040/D041 V4.20
D062/D063/D065/D066 V5.09.04
D067/D068/D069/D072 V6.04
D081/D082 V7.03.09
[NOTE]

To use GSNX V1.4 SDK application with BE-C1 (D046/D049), the following versions of system
firmware and a VM card are required.

System firmware:
V3.00.1 or later

Printer Firmware (necessary when using the Printer Option):
V3.01 or later

VM Card: V4.22 or later

NOTE:
RCL will prepare a special VM card including a NTL Filter (V2.2.7 or later) for BE-C1
(D046/D049).
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Installation

Confirmation Points before Installation

Make sure that the system firmware of the target machine is the latest version.
Make sure that the firmware of the VM card is the latest version

GlobalScan NX requires that the device’s Auto Off Timer be set to 5 minutes
or longer. This is because the device might not work correctly if it enters
Sleep Mode before the VM, GlobalScan NX applications finish starting up.

To use GlobalScan NX with the following models, please have the customer
purchase memory modules to expand the available system (MFP) memory:

AL-C1(D009/D011/D012/D013), R-C5(D017/D018/D019/D020) (monochrome
scanner models): Needs to be expanded to 768MB (max.).

DI-C1(D037/D038/D040/D041): Needs to be expanded to 1024MB (max.).

For AL-C1(D009/D011/D012/D013) and R-C5(D017/D018/D019/D020), the IPDS
option and Global Scan NX (Java VM) cannot be used at the same time.

Installation of GlobalScan NX (L)

Al A

Turn

off the target machine.

Install the VM card in the service slot of the target machine.

Turn
Turn

on the target machine.
off the Auto Off Timer.

Ask a machine administrator to login to the target machine with the login name and
password of the machine’s administrator.

| € User Tools / Counter / Inquiry

Copder / Document Server o

% Features Co%’ Esrafiol
ri'ﬂ.' am Setting

@B Facsimile Features EI naury

& Printer Features

é Scarrer Features
nter g Extendad Faature Settings «

Triten St b List
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6. Enter the "User Tools", and then press "Extended Feature Settings" on the LCD.
(ENote )

|. For 4-line LCD models, use Web Image Monitor to perform Step 5-10. |

™ Extended Feature Setting Menu

Extended Feature Settings « JavaT™™ Platform

gl_i105
7. Press "Extended Feature Settings" on the LCD.
8. Allocate the Function key (on the operation panel) for the Java VM applications if the
customer wants to use a key other than "Other Functions" (default).
9. Enter the "Extended Features Settings".
= "User Tools/Counter" > "Extended Features Settings" > "Extended Features
Settings"
- Extended Feature Settings

Startip [ | Change Extended || Administrator
Setting | =l tirstall Mllocation \| Featwe info || Tools \h
L] e

Select item(s) to set.

Copy Extended Features

Web Installation Settings

I Heap / Stack Size Settings ; Ih

L:“II 16
10.Press the "Administrator Tools" tab, and then press the "Heap/ Stack Size Settings"
button.
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Heap / Stack Size Settings [ el [
Specify size(s).
PHeap Size <2 Mo GRS

“M | Defaits

P-Stack Size <32 KB to 128 KB>

B : | o || Restoeosairs |

System Memory Heap
Free 38,674,432 3,008,132
Total 203,923,456 8,388,608

| |_i117
11.Press the "Change" button.

Heap / Stack Size Settinas B
Specify size(s). 8
BHezo Size <2 VB to 16 VB>

| Change || Restore Defaults I |_Eleet—

P-Stack Size <32 KB to 128 KB>

KB | rame || Restore Defaults |

System Memory Heap
Free 38,674,432 5,008,200
Total 203,923,456 8,388,608

gl i118

<4-line LCD models>

Administrator Tools

| Apply | | Back |

Web Installation Settings

B \Web Installation Settings : O on ® off
B HTTP Proxy : O on @ off
Port :| |

User Name :| |

Password :

® URL |

Sarver

Heap / Stack Size Settings

B Heap Size :|12| |MEI (2 - 18 MB)

® Stack Size |64 KB (32 - 54 KB)
B Memory Status
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12.Input an appropriate value (see the table below) with the numeric keys on the operation
panel, and then press the "# (Enter)" key.
Required heap size for the " Heap/ Stack Size Settings" depends on a combination of
installed applications. For details, refer to the table below.

GlobalScan NX CAP ELP-NX | Required Heap Size
Yes - - Default Setting
Yes Yes - 16 MB
Yes Yes Yes 16 MB

13.Press the "OK" button to return to the previous screen.
14.Press the "User Tools/Counter" key to exit the UP mode.
15.Turn the target machine off and on.

16. Set the Auto Off Timer to “5 minuties”.
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Remote Updating Procedure

Updating of GlobalScan NX SDK application

{5 Important )
e First update the Java VM Platform if the Java VM Platform and GlobalScan NX
SDK Application are supposed to be updated at the same time.
e |t is not possible to update Ver1.1.X directly to Ver1.4.x.
e Make sure to turn off the Auto Off Timer. If the timer is left on, the
machine will enter Auto Off Mode while the installation is in progress,
causing the installation to fail.

—

Ask a machine administrator to stop the GlobalScan NX SDK Application with the

operation panel (the procedure for stopping a GlobalScan NX SDK application is

described below for reference).

OnNote

e Stop other SDK Applications if they have been installed in the machine.

e You can also stop the GlobalScan NX SDK Application with the web image
monitor (the procedure for stopping a GlobalScan NX SDK application is
described below for reference).

Launch the Remote Manager.
Add a GlobalScan NX SDK Application for updating in the Remote Manager

“

CiNote )
e File name of the zip file is subject to change.
e See the "Adding a DSDK Application in the Remote Manager" sub section of
the "DSDK Application Installation" section of the "Embedded Software
Remote Manager Operation Guide".

SYN

4. Install the GlobalScan NX SDK Application for updating in the target machine
@ Note )
See the "Installing the DSDK Application in the Target Machine" sub section of the
"DSDK Application Installation" section of the “Embedded Software Remote
Manager Operation Guide”.

Turn off and on the target machine.

Ask a machine administrator to check if the version of the GlobalScan NX SDK
Application is updated and if the installed GlobalScan NX SDK Application is "Starting
Up".

o o

To stop a GlobalScan NX SDK application with Operation Panel

1. Press User Tools/Counter key on the machine's operation panel.
2. Log in the "User Tools" using a machine administrator account (user name and
password).
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€ User Tools / Counter / Inauiry

% Copier /E:Catfnn:sm Server gga Espariol

Facsimile Features m Inauiry

Printer Features

fe‘ Systern Settings

Scanner Features ‘

ﬁ Mairtenance ‘

Counter

Extended Feature Settings

Ed | |Iw (&

= = . FEB 27,2008
[ System Status Job List TN

av2i063

3. The screen shown above is displayed.
4. Press "Extended Features Settings".
E Extended Feature Setting Menu | Bit |
‘ Extended Feature Settings ‘ | JavaT Platform ‘

cav2i064
5. The screen shown above is displayed.
6. Press "Extended Features Settings".

= Extended Feature Settings
Startup : Change Extended |\ | Administrator
j Setting e [ V Aliocation \| Feature Info || Tools \
Select extended feature(s) to start or stop.
Priority  Status Tvoe Fctendad Featire Mame Descriotion Version  Startio Location
[Pricrity| Suspend | | Type-J [GlobalScan NX 1.00 SD CadSlot 3 |
StartingUp | Type-C |JavaT Flatforn |PREO2 Extended Feat... 2.13 SD Card Slot 3 |

v2i093
7. Press the GlobalScan NX SDK application bar to stop the application.



o Extended Feature Settings

Startip . Change Extended | [Administrator
j Setting Install V Uhinstall. V Allocation | Feature Info || Tools
Select extended featura(s) to start or stop.
Priority]  Status Type Extended Feature Neme Description Version  Startup Location
Pricrity} Stop Type-)  [GlobalScan NX 1.00 SD CardSlot 3 |
Starting Up | Type-C JavaTM Platform  PREOZ Extended Feat... 2.13

SD Card Slot 3

cav2i094
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8. "Stop" is displayed in the Status column and the GlobalScan NX SDK application bar

turns white when the GlobalScan NX SDK application is stopped.

To stop a GlobalScan NX SDK application with Web Image Monitor

2 RHPACT FAS - Web kmage Moritor - Microsoft Internet Explorer

1. Access the target machine’s Web Image Monitor.
2. Click the "Login" button.

a- v Y sewch « il Prdimages 7 QuekSeach +
Ltz ek e i ot o e e (R ol W e[ .
= () 71§ f{Login
RICOH Aficio MP C3000 web image martor
Hae Home Enghah ¥ [Elntes @ ©
Drocument Serms
St | Devielfs | Comder| | Ingury
Fix Facennd File
P et i :Dwml‘hn ICOM Aficia MP 3000 .
Location. =
b o Comment Sl — y
e R b 1 ousccsoaoe Ve
Suares A
Priter UL Awn ]
=t Printer:
G Akt
— Ho Paper: Tray 1
Fax [ At | NoPaper Trav 4
Tone 2
Bl wHNEEE
O L -
] pore D Irtenet
cav2i052
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RICOH

Web Image Monitor

Login User Name : I

Login Password : |

Gancel

cav2i088
3. Login to the target machine using a machine administrator name and password.

RICOH Aficio MP €3500 et image Manitor

Home Home
Docummenit Server
Status | DeviceInfo | | Counter | Inquiry
Fax Recerved File
Printer- Print Jobs B Device Hame : RICOH Afico MP C3500 / > N

B Location
ok B Comment

,\}:\"- - e === )

[ n LN

N e R N
| |

-
Status
System Call Seavice
Printer % Toner Almost Empty 22 Printer =
Copier ¥4 Toner Almest Empty 22 m ﬁg H” ;
" Lows: Yelkom Toner
Fax U At 2 Parsl Off Mode
Scarmer ¥ Enengy Sever Mode Lald =
cavzi089
H n H H "
4. Click "Configuration".
-
RICOH Aficio MP C3500 \veb Imaas Monitor :
gy e u S5LTLS
g ’ W Basic Settings sk
W Teay Paraznatess (FCL) W Sate Certificate
B Device Centificate
| Fax
E
T4V Environsment Settings -E!':‘"_E- RC Gate
W Send | Reception Settings Ul w Setup RIC Oute
W IP-Fax Settings W Update RC Gats Fimwaze
W IP.Fax Ciateway Settings B R Gate Proxy Server
W Parumates Sattings
. Webpage
_Q Interface - Welpage
W Interfice Settings
Extended Feature Settings
=
Exienoed Festure 110
W Iostall
W Uninstall
W Change Aliceation

B Admmstrator Tools
B Copy Extended Featurms
W Copy Card Save Deta

cav2i090
5. Click "Startup Setting" in the "Extended Feature Settings" section.



Startup Setting

Back

= s

1

Total Appheations 2

Selection  |§ Extended Feature Hame

o Clobalfean NX

o JevaT Platform
Back

RICOH Aficio MP C3500 \veb image Monitor

& | Pronity Type |Status

Description
1 Starting Up
c Starting Up FRED2 Extended Featurs{JavaTM Platform)

click the "Start Up/Stop".

Versaon
100

213

cav2i091
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6. Check the radio button of a GlobalScan NX SDK application to be updated, and then

Startup Setting

Back

7 Jstart UpfStop (/| ProrityiCancel

mn
Total Applicatiors 2
Seloction | Extended Featare Name
c GlsbalSean NX (]
(s JevaTM Platform B
Back

B  Prionity Type

I

c

RICOH Aficio MP C3500 \veb image Monitor

States Descoiption
Stop

Tateg Up | PREDZ Extended Featurs(JavaTM Platform)

Vemon
100

213

cav2i092

"Stop" is displayed in the Status column if the GlobalScan NX SDK application is
stopped.
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Model: GlobalScan NX

Date: 05-Aug-10 No.: RD420008

Correct items

e Table listing target MFP models and supported VM versions.

e Remote Updating Procedure was corrected.

Subject: GlobalScan NX Installation/Uninstallation/Update
Guide

Prepared by: T. Nihei

From: 1st Overseas Tech Support Sec., 1st PQM Dept.

Classification: |[L] Troubleshooting [] Part information ] Action required
[] Mechanical [] Electrical [] Service manual revision
[] Paper path [] Transmit/receive ] Retrofit information
[] Product Safety [X] Other ( ) X Tier 2

This RTB has been issued to announce the GlobalScan NX SDK Application version 1.4.x
Installation / Uninstalltion / Update Guide release information.
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Target MFP models and supported VM versions.

For each MFP model, make sure to install the following or newer version.

Model Name VM Ver.
B222/B224 V2.15
B230/B237 V2.15
B246/B248/B249 V2.15
D052/D053/D054 V2.15
D009/D012 V4.20
D011/D013 V4.20
D014/D015 V4.20
D017/D019 V4.20
D018/D020 V4.20
D046/D049 (see [NOTE]) | V4.22
D084/D085 V4.20
D091/D092 V4.20
D023/D025 V4.20
D027/D029 V4.20
D037/D038/D040/D041 V4.20
D062/D063/D065/D066 V5.09.04
D067/D068/D069/D072 V6.04
D081/D082 V7.03.09
[NOTE]

To use GSNX V1.4 SDK application with BE-C1 (D046/D049), the following versions of system
firmware and a VM card are required.

System firmware:
V3.00.1 or later

Printer Firmware (necessary when using the Printer Option):
V3.01 or later

VM Card: V4.22 or later

NOTE:
RCL will prepare a special VM card including a NTL Filter (V2.2.7 or later) for BE-C1
(D046/D049).
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Installation

Confirmation Points before Installation

® Make sure that the System firmware of the target machine is the latest version.

® Make sure that the version of Java VM installed to the card is the latest version.
(See the “Release Note of GlobalScan NX SDK Application” regarding the System
firmware and Java VM version requirements.)

® Only the Card Authentication Package (CAP) and Enhanced Locked Print NX
(ELP NX) SDK applications are supported for use with the GlobalScan NX SDK
application. Other Type C or Type J SDK applications are not supported.

® Please confirm the version compatibility between GlobalScan NX and CAP. For
details, refer to the following table:

CAP V1.3 CAP V14
XG-SD V1.3 OK OK
XG-SD V1.4 OK OK

® GlobalScan NX requires that the device’s Auto Off Timer be set to 5 minutes
or longer. This is because the device might not work correctly if it enters
Sleep Mode before the VM, GlobalScan NX applications finish starting up.

® To use GlobalScan NX with the following models, please have the customer
purchase memory modules to expand the available system (MFP) memory:

® AL-C1(D009/D011/D012/D013), R-C5(D017/D018/D019/D020) (monochrome
scanner models): Needs to be expanded to 768MB (max.).

® DI-C1(D037/D038/D040/D041): Needs to be expanded to 1024MB (max.).

® For AL-C1(D009/D011/D012/D013) and R-C5(D017/D018/D019/D020), the IPDS
option and Global Scan NX (Java VM) cannot be used at the same time.

Installation of GlobalScan NX SDK Application

There are two installation methods for the “GlobalScan NX SDK Application”. You can
choose one of these installation methods;
® For installing in a small number of machines, "Installation Method 1" is
recommended.
® For installing in a large number of machines, "Installation Method 2" is
recommended.



PAGE: 5/18

Installation Method 1

1.
2.

3.

@ Note )

e This method is not usable with 4-line LCD models due to the limited display
capabilities of the S-C4’s 4-line LCD panel.

Prepare the GlobalScan NX SDK application on your PC.

Unzip the GlobalScan NX SDK application file to create the “336920832” folder and

“package.xml” file.

(5336920832,
packagexml
Insert a VM card to a Panasonic SD Card Reader/Writer that is connected to the PC.
Access the VM card, and verify that the following folders exist. Copy the “336920832”

folder to the "dist" folder (sdk/dsdk/dist) of the VM card, as shown below.

S APPL COMMI (B

1 ewinitd

=3 module

= I =dk

16974092
= ap
] Comman
= dedk

— :
# [ server %@9&920832;

F

1 F =

Remove the VM card from the Panasonic SD Card Reader Writer.

Go to the target machine and insert the VM card into the service slot when it is turned
off.

Turn on the target machine, and Java VM will install itself on the target machine.

Ask the machine’s administrator to login to the target machine as an administrator.
Press the "User Tools" key, and then push the "Extended Feature Settings" button on

the operation panel.

«» User Tools / Counter / Inquiry

Copier / Document Server © .

% Features c,% Frangais

GB Facsimile Features El Iruiiry
% )

.I h Printer Features

é Scanner Features

A ‘
@I Counter ‘ E3 Extended Feature Settinos

System Settings

System Status 14:13

9. Next, select "Extended Feature Settings".
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E Extended Feature Setting Menu

‘ Extended Feature Settings ‘ ‘ JavaTH Platforn ‘

System Status

10. Select the "Install" tab, followed by "SD Card".

= Extended Feature Settings

Startup \ ! Change Extended Administrator
Setting il w Uil w Allocation VFeature Infow Tools \

Select a source media, then select extended feature(s) to install.

[Media Type Extended Feature Name Description ‘ersion Source
SD Card | | Type-)  |GlobalScan WX 1.00 SD Card Slot 2 ‘
| Type—=C  |JavaTM Platform Extended Feature(Ja... 4.07 SD Card Slot 2 ‘

System Status

11.Select GlobalScan NX, and select the service slot (the actual slot will vary depending
on the machine) and “Auto Start”. By selecting “Auto Start”, the GlobalScan NX service
will automatically start-up after completing the activation process and rebooting the
machine. Press "Next" to continue this installation procedure.

Extended Feature Installation Cancel l I Mext

Select installation target and startup method.

P nstall to

Iachine HOD

| SDCadSlot1 | [ 5D CardSlot 2

PStartup Method
Auto Start | | Do not Auta Start

System Status
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(5 Note )

e Do not install “GlobalScan NX” to the HDD of the target machine.

o Switching GlobalScan NX manually between "Stop" and "Starting-up" on the
operation panel might cause the device to run out of memory. So, we
recommend using Auto Start.

12. Verify that the displayed SDK application name and version number are correct.

Ready to Install I Cancel II Previous ” oK l

Confirm the information below, then press [OK] to start installation.

W Exctended Feature Marme: GlobalScan MY »Product 1D 336920832
PDescription:
»ersion: 1.00 P Auto Start: Auto Start

P Installation Target: 5D Card Slot 2

- Vendor:

W Contact: TEL:
Fa:
E-rriil:

5AUG 2008

(5 Note )

e If the displayed SDK application is not what you want to install, verify that the
contents of the VM card are correct and retry this installation.

13.Press "OK" to complete this installation.

14.Java VM applications use the "Other Functions" key by default. If the user wants re-
assign the key used to access GlobalScan NX, please use the “Change Allocation” tab,
located on the “Extended Feature Settings” screen.

E Extended Feature Settings B

Startup - Chanoe Extencded Administrator
‘ Setting w Install w Uninstall VAHocatiom \1Feature Infow Taoals \

Select an extended feature to chanoe key allocation.

Status Exctended Feature Mlame Cescription Yersion Allocated Key
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15.Press the "Administrator Tools" tab, and then press the "Heap/ Stack Size Settings"
button.

= Extended Feature Settings

[ |
Startup | ; Change Extended
‘ Setting V =l \ et Allocation |/ Feature Info

Select item(s) to set.

1

Copy Extended Features I

Web Installation Settings |

In Heao / Stack Size Settings | Ih

16.Press the "Change" button.

Heap / Stack Size Settings [ el [

Specify size(s).
P Heap Size <2 MREo 1o M=

| o || =

P-Stack Size <32 KB to 128 KB>

KB I. Change | I Restore Defaults |

System Memory Heap
Free 38,674,432 3,008,132
203,923,456 8,388,608

System Status

gl_i117

17.Input the appropriate value using the numeric keys on the operation panel and then
press the "# (Enter)" key.
The required heap size depends on the combination of installed applications. For
details, refer to the table below:

GlobalScan NX CAP ELP-NX | Required Heap Size
Yes - - Default Setting
Yes Yes - 16 MB
Yes Yes Yes 16 MB
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18.Press the "OK" button to return to the previous screen.

Heap / Stack Size Settings | Caﬂ"![ oK '
Specify size(s).
B Hean Size <2 MB to 16 VB>

B | cwme || RestoreDefaits | g
Btk oae <32 KB to 128 KE>
KB | Change |I Restore Defaults e

System Memory Heap
Free 38,674,432 3,008,200
Total 203,923,456 8,388,608

System Status Job List

18
19.Press the "User Tools" key to exit the UP mode.
20.Turn the target machine off and on.

21. Activate "GlobalScan NX" using Remote Manager.

(ENote )

e For details, see "Product Activation" in the "Embedded Software Remote
Manager Operation Guide".

22.Reboot the MFP. If using Auto Start (as recommended), GlobalScan NX will start up

after activation and rebooting the MFP.

ONote

1.Both Web Image Monitor and the MFP’s Extended Feature Settings screen
may display the status of GlobalScan NX as “Suspend”. This is equivalent to
“Starting Up” and is normal behavior.




PAGE: 10/18

Installation Method 2
{5 Important )

e Make sure to turn off the Auto Off Timer. If the timer is left on, the
machine will enter Auto Off Mode while the installation is in progress,
causing the installation to fail.

1. Install the GlobalScan NX SDK application to the target machine using Remote

Manager.

@ Note )

e Use the zipped file as it is (do not unzip it).

e For the correct procedure, see the "Installation and Activation" section in the
"Embedded Software Remote Manager Operation Guide".

2. Activate "GlobalScan NX" using Remote Manager.

ONote )

For details, see "Product Activation" in the "Embedded Software Remote

Manager Operation Guide".

Access the target machine’s Web Image Monitor.

Login to the target machine using a machine administrator name and password.

Click the “Configuration” button.

Click “Extended Feature Info”.

Click the “Details” icon for “GlobalScan NX” (see below).

NoO O AW

RICOH Aficio MP C3300 web image Monitor

Extended Feature Info

Back
i _
Total Applications:2
Extended Feature Name Priority |Type |Status Description
GlobalScan NX 3 .Star'ting Up .
JavaTM Platform I Starting Up  |Extended Feature(lavaTM Platfarm)

8. Make sure that Auto Start is set to “On”. (Default: On)
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RICOH Aficio MP €3300 eb Image Monitor

Extended Feature Info

|- Back |

B Extended Feature Mame : GlobalScan MX
B Description :
B \ersion nE A
B Product ID L 330920832
B Startup Location : SD Card Slot 2
B Vendor :
B Contact
TEL
Fax
E-mail :
| ® Auto Start : On |

9. Reboot the MFP using the “Reset Device” button located on the Web Image Monitor
main page. As long as Auto Start set to “On”, GlobalScan NX will start up automatically
after activation and the MFP has been rebooted.

[es] 1) |2
RICOH Aficio MP C3300 Web Image Monitor

Home Home |English v

Document Server
Status | | Device Info | | Counter | | Inguiry
Printer: Print Jobs

Johb W Device Mame : RICOH Aficio MP C3300 —

B Location - ; =
Address Book B Comment — S
S W Host Mame : RMNPFBE21B % m’ L
Reset Device Reset Printer Job | i - -
Status
-
(E Note )

e Both Web Image Monitor and the MFP’s Extended Feature Settings screen
may display the status of GlobalScan NX as “Suspend”. This is equivalent to
“Starting Up” and is normal behavior.

10. If required, change the “Heap/ Stack Size Settings" using Web Image Monitor.
Heap/Stack Size can be set on the screen accessed by Configuration > Extended
Feature Settings > Administrator Tools



Administrator Tools

| Apply | | Back

Web Installation Settings

B Webh Installation Settings
B HTTP Proxy

Server

Port

User Nams

Password
B URL
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Heap / Stack Size Settings

B Heap Size
B Stack Size

MB (2 - 16 MB)

KB (32 - 64 KB)

B Memory Status

(5 Note )

e The required heap size depends on the combination of installed applications.
For details, refer to the table below:

GlobalScan NX CAP ELP-NX | Required Heap Size
Yes - - Default Setting
Yes Yes - 16 MB
Yes Yes Yes 16 MB
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Uninstallation

Uninstallation of GlobalScan NX SDK application

1. Turn on the target machine.

2. Deactivate the "GlobalScan NX" application using Remote Manager. For details, see
"Deactivation" in the "Embedded Software Remote Manager Operation Guide".

- Before uninstalling activated SDK applications, deactivation must be done.

| Otherwise, the product key will become unusable.

3. Uninstall the GlobalScan NX SDK application, but not the Java VM application, using
the operation panel or Remote Manager.
@ Note )

o Please use Remote Manager if the target MFP is 4-line LCD model.

4. Reboot the target machine.
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Remote Updating Procedure

Updating of GlobalScan NX SDK application

(5 Important )

e First update the Java VM Platform if the Java VM Platform and GlobalScan NX
SDK Application are supposed to be updated at the same time.

e Make sure to turn off the Auto Off Timer. If the timer is left on, the
machine will enter Auto Off Mode while the installation is in progress,
causing the installation to fail.

—

Ask a machine administrator to stop the GlobalScan NX SDK Application with the

operation panel (the procedure for stopping a GlobalScan NX SDK application is

described below for reference).

© Note )

e Stop other SDK Applications if they have been installed in the machine.

e You can also stop the GlobalScan NX SDK Application with the web image
monitor (the procedure for stopping a GlobalScan NX SDK application is
described below for reference).

Launch the Remote Manager.
Add a GlobalScan NX SDK Application for updating in the Remote Manager
OnNote
e File name of the zip file is subject to change.
e See the "Adding a DSDK Application in the Remote Manager" sub section of
the "DSDK Application Installation" section of the "Embedded Software
Remote Manager Operation Guide".

SYN

4. Install the GlobalScan NX SDK Application for updating in the target machine
© Note )

[See the "Installing the DSDK Application in the Target Machine" sub section of the
"DSDK Application Installation" section of the “Embedded Software Remote
Manager Operation Guide”.

Turn off and on the target machine.

Ask a machine administrator to check if the version of the GlobalScan NX SDK
Application is updated and if the installed GlobalScan NX SDK Application is "Starting
Up".

o o

To stop a GlobalScan NX SDK application with Operation Panel

1. Press User Tools/Counter key on the machine's operation panel.
2. Log in the "User Tools" using a machine administrator account (user name and
password).
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€ User Tools / Counter / Inauiry

% Copier /E:Catfnn:sm Server gga Espariol

Facsimile Features m Inauiry

Printer Features

fe‘ Systern Settings

Scanner Features ‘

ﬁ Mairtenance ‘

Counter

Extended Feature Settings

Ed | |Iw (&

= = . FEB 27,2008
[ System Status Job List TN

av2i063

3. The screen shown above is displayed.
4. Press "Extended Features Settings".
E Extended Feature Setting Menu | Bit |
‘ Extended Feature Settings ‘ | JavaT Platform ‘

cav2i064
5. The screen shown above is displayed.
6. Press "Extended Features Settings".

= Extended Feature Settings
Startup : Change Extended |\ | Administrator
j Setting e [ V Aliocation \| Feature Info || Tools \
Select extended feature(s) to start or stop.
Priority  Status Tvoe Fctendad Featire Mame Descriotion Version  Startio Location
[Pricrity| Suspend | | Type-J [GlobalScan NX 1.00 SD CadSlot 3 |
StartingUp | Type-C |JavaT Flatforn |PREO2 Extended Feat... 2.13 SD Card Slot 3 |

v2i093
7. Press the GlobalScan NX SDK application bar to stop the application.
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o Extended Feature Settings

Startup . Change Extended | | Administrator
J Setting e V Uninstell V Allocation | Feature Info || Tools
Select extended feature(s) to start or stop.
Priority]  Status Type Extended Feature Neme Description Version  Startup Location
Pricrity} Stop Type-)  [GlobalScan NX 1.00 SD CardSlot 3 |
Starting Up | Type-C JavaTM Platform  PREOZ Extended Feat... 2.13 SD Card Slot 3

V2i094
8. "Stop" is displayed in the Status column and the GlobalScan NX SDK application bar
turns white when the GlobalScan NX SDK application is stopped.

To stop a GlobalScan NX SDK application with Web Image Monitor

2 RHPAC JAY - Web kmage Monitor - Microsoft Interret Explores
Q- O W @@ Pwwsr ylyrenme @3- 5 - )i
A ] bl ooooooons oo <8
a B0 sewch =l P dmages 17 QuiekSearch +
LEXMARK = Frre o [@hormal [0k [@tiack ond wtte [Tt oty | [Wllotos | [Hlerevies
= () 71§ f{Login
RICOH Aficio MP C3000 veb imas
Home Home Enginh v ([Sjreteh (@)
Docement Serves
Stes | Devieelifs  Comtn | laqery
Fuz Racenad File
P Pk S 8 Devios Hume - RICOM Aficin MP C3000
= = Location -~
&b & Coaoment ~ Sl —
damtn W ot Hane  XOCOO0000C \\% . m—-!
Siabu i
Frater [ Awn
Printer;
o U Alent
= Ho Paper: Tray 1
Fu [ Aten o Paper: Tray 4
Seaseer ) Reaty
Tomer A
i ol
O L @
8 0o D Irtenet

cav2i052
1. Access the target machine’s Web Image Monitor.
2. Click the "Login" button.
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RICOH

Web Image Monitor

Login User Name : I

Login Password : |

Gancel

cav2i088
3. Login to the target machine using a machine administrator name and password.

RICOH Aficio MP €3500 et image Manitor

Home Home
Docummenit Server
Status | DeviceInfo | | Counter | Inquiry
Fax Recerved File
Printer- Print Jobs B Device Hame : RICOH Afico MP C3500 / > N

B Location
ok B Comment

,\}:\"- - e === )

[ n LN

N e R N
| |

-
Status
System Call Seavice
Printer % Toner Almost Empty 22 Printer =
Copier ¥4 Toner Almest Empty 22 m ﬁg H” ;
" Lows: Yelkom Toner
Fax U At 2 Parsl Off Mode
Scarmer ¥ Enengy Sever Mode Lald =
cavzi089
H n H H "
4. Click "Configuration".
-
RICOH Aficio MP C3500 \veb Imaas Monitor :
gy e u S5LTLS
g ’ W Basic Settings sk
W Teay Paraznatess (FCL) W Sate Certificate
B Device Centificate
| Fax
E
T4V Environsment Settings -E!':‘"_E- RC Gate
W Send | Reception Settings Ul w Setup RIC Oute
W IP-Fax Settings W Update RC Gats Fimwaze
W IP.Fax Ciateway Settings B R Gate Proxy Server
W Parumates Sattings
. Webpage
_Q Interface - Welpage
W Interfice Settings
Extended Feature Settings
=
Exienoed Festure 110
W Iostall
W Uninstall
W Change Aliceation

B Admmstrator Tools
B Copy Extended Featurms
W Copy Card Save Deta

cav2i090
5. Click "Startup Setting" in the "Extended Feature Settings" section.



RICOH Aficio MP C3500 \veb image Monitor
Startup Setting

Back

= s

1

Total Appheations 2

Selection | Extended Feature Hame B Pronty Type Status

(o GlobalSean NX B 1 Starting Up

(o JavesTH Platform 2 c Starting Up
Back

Description

FRED2 Extended Featurs{JavaTM Platform)

Versaon
100

213

cav2i091
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6. Check the radio button of a GlobalScan NX SDK application to be updated, and then
click the "Start Up/Stop".

RICOH Aficio MP C3500 \veb image Monitor
Startup Setting

Back

7 Jstart UpfStop (/| ProrityiCancel
m

Total Applicatiors 2
Seloction | Extended Featare Name
GlebalSean NX

B  Prionity Type] States Descoiption
c B 1 Stop
JevaTM Platform B

c fastng Up

pe

Back

PRED2 Extended Feature{JavaTM Platform)

cav2i092

7."Stop" is displayed in the Status column if the GlobalScan NX SDK application is
stopped.
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Abstract

Notification

This document is written based on the understanding that GSNX is already installed and
working. As described in the “GlobalScan NX Installation/Uninstallation/Update Guide”,
this means:

e Any required Hardware Options are attached (Optional Memory, etc.)

e The Heap/Stack Size settings configured correctly:

GlobalScan NX CAP ELP-NX | Required Heap Size
Yes - - Default Setting
Yes Yes - 16 MB
Yes Yes Yes 16 MB

e The Auto Off Timer is set to 5 minutes or longer.

Preparation

Please review the customer’s environment before starting the v1.5.2 update. Information
that should be reviewed and confirmed is as follows:
Customer Models
- Java VM cards
- Latest System FW
GSNX Edition (Server/Serverless)
FAX function is used or not.
Other installed SDK applications
- If the customer uses an SDK application that requires activation (such as CAP),
please prepare the object and a new product key in advance.
- Please confirm that the installed version of CAP is compatible with GSNX. For
details, refer to the following table:

CAP V14
GlobalScan NX V1.5 OK
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Procedure (Outline)

1. (If the fax function is used) Change the Reception File Setting from “Store” to “Print” in
the Facsimile Features menu.

Update the GSNX PC application and optional plug-ins.

Deactivate the GSNX SDK application and any other applications which require
activation.

Replace the VM card.

Install the GSNX SDK application.

Install the other SDK applications.

Synchronize the GSNX profile with the devices.

Confirm that the profiles were distributed properly.

(If the fax function is used) Set the Reception File Setting to “Store” in the Facsimile
Features menu.

SFN

©CON® O~

@ Note )
To avoid unexpected trouble, do not synchronize the PC application with the
SDK application until after the SDK application is upgraded to v1.5.2.

@ Note )
If you are already familiar with the procedures required by the above steps, you
do not need to continue using this document.
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Target MFP models and supported VM versions

For each MFP model, make sure to install the following or newer VM version.

Firmware
Model Code Java VM Parts Number Version (System) Version
B222/B224 B8619900 V2.15 B2215601S V1.70
B230/B237 B8619900 V2.15 B2385601X V1.71
B246/B248/B249 B8619900 V2.15 B2475101W V3.05
D052/D053/D054 B8619900 V2.15 B2475101W V3.05
D009/D012 D3779900 V4.23 D0125751V V1.13
D011/D013 D3779900 V4.23 D0135751V V1.13
D014/D015 D3779900 V4.23 D0145761N V1.12
D017/D019 D3779900 V4.23 D0195331P V1.17
D018/D020 D3779900 V4.23 D0205331P V1.17
D046/D049 D3779900 V4.23 D0465749A V3.01
D084/D085 D3779900 V4.23 D0855751B V1.01
D091/D092 D3779900 V4.23 D0925751B V1.01
D023/D025 D4309900 V4.23 D0255562V V1.24
D027/D029 D4309900 V4.23 D0295562V V1.24
D038/D041 D4309900 V4.23 D0395521J V1.17
D062/D063/D065/D066 | D4639900 V5.12 D0625572H V1.19
D067/D068/D069/D072 | D4679900 V6.07 D0675530D V1.02
D115 D4679900 V6.07 D1155530A V1.03
D081/D082 D0819901 V7.09.3 D0815760D V1.03
D093/D094 D5069900 V7.09.3 D0935605A V3.01
D088/D089 D0899900 V7.09.3 D0895562J V2.05
D086/D087 D0899900 V7.09.3 D0875562H V1.05
D104/D106 D1069900 V7.09.3 D1055730D V1.02
M022/M024/M026/M028 | M0269900 V7.09.3 M0265771F V1.04
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GlobalScan NX PC Software Upgrade

Pre-Check

Before upgrading the PC Software, please check the following:

#1. Is Serverless Edition installed? [Yes, NOJ

#1.1. If Yes, does the customer want the job/error log saved? [Yes, No]
#2. Is the Load Balance or Secondary Delivery Server function used? [Yes, No]
#3. Are any Optional Plug-ins installed? [Yes, No]

#3.1. If Yes, is the MS SharePoint Server plug-in installed? [Yes, No]

@ Note )
Try to get the answers from the customer. If this is not possible, check them
yourself using the procedures described in Appendix A-D.

Procedure

@ Note )

ISteps 1, 2, 3 and 8 (in Bold) are mandatory. The other steps are optional.

1. Perform a Manual Backup (for safety).

2. Download a Backup File (for safety).

3. Export a Device List (for safety).

(If #1.1 is “Yes”) export the System Log and Job Log.

(If #1.1 is “Yes”) download the Error jobs.

(If #2 is “Yes”) disable the Secondary Delivery Server/Load Balance settings.
(If #3.1 is “Yes”) uninstall the MS SharePoint Server Plug-in.

Upgrade the GlobalScan NX (v1.5.2) Software.

4,
5.
6.
7.
8.
9. (If #3 is “Yes”) upgrade the GlobalScan NX Optional Plug-ins.
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1. Perform a Manual Backup (for safety)

1. The Backup menu is available from the [Maintenance] tab of the [Maintenance Settings]
screen.

GlobalScan NX

e —
Home Configuration Maintenance Settings Job Management Logs

Maintenance System Control

A Built-in Administrator | Logout |

Maintenance

Task in Process

Y

SlotNe. Date/Time [ commant
1 Blank [
2 Blank
3 glank
4 Elank
S Blank
6 Blank
7 Elank
3 Blgnlf

2. Select (highlight) a slot.

3. Click [Backup].

Scheduled Backup

e Add rd r

Sohedule M. Backup Start Datef Bachup ot Ne. Sackup Desoription Frevisus Enecwtl Previeus R Cenmsest

4. A message will appear with a [Comment] field. Enter a comment if desired, and then
click [OK]. Another message will be displayed indicating that the Backup operation was
successful.

5. Click [OK]. The newly-created backup file will have been added to the list.

Slot Wo. Date/Time Comment &
1 06/09/2009 17:41:56 Jure L -
2 HBlank r

3 Blank
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2. Download a Backup File (for safety)

1. Select the backup data you created in the previous section.

2. Click [Download].

You can set a password to protect the backup file. If entered, this password will be
required when the backup file is uploaded. Only alphanumeric characters can be used for
the password.

3. If using a password, please enter it twice.

Download

@ Confirm

Do you want to download?

Password |

Confirm Password

- Cancel |

4. Save the backup file to the desired location.
A message will appear indicating that the download operation was successful.

3. Export the Device List (for safety)

Please export the current device list.
To export the device list, please click the “Export Device List” button after selecting all
registered devices.

m Maintenance Settings Job Management

System Profile Device

Device List
I7O device

[@ Add | | 4 Edit || Delete | |EE Profile Batch Configuration |lﬁ::> Synchronize |

|+[Z| Import Device List | |[Z}+ Export Device List |

IP Address/fHost Ni¢ Device Name Model Screen Size Profile Mame
P e e e W23 Aficio MP C7501 WG bartest(pf_1)
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4. Export the System Log and Job Log (Serverless Edition Only)

@ Note )
[This step can be skipped if Server Edition is used. |

If your customer wants to save the MFPs’ Job and System Logs, please export them. Do
not forget to export them from all target MFPs.

Procedure:
1. Open the Log screen, select the desired log, and then select a target device (MFP) by
clicking the displayed device name to open a device selection dialog.

H “ ”
2. Click the “Refresh” button to update the log.
3. Click the Export button and input a file name.
Home Configuration Maintenance Settings Job Management
| Job Log System Log |
System Log | V-C3("~~ "~~.166.118) | [ auto [€ Refresh
| Search | | Display All |
L
| [ Delete all |||z Export | 5 logs
Recorded Date/Timev  Level Job ID  Error Code Error Message Action Message Remarks
05/31,/2011 10:14:24 ERROR 6703555 54010003  Failed to deliver the data to th smb error ocours
05/31/2011 10:11:23 ERROR | 67c355t| 54010002  Failed to deliver the data to th smb error ococurs
05/31/2011 10:08:22 ERROR | 67c355%5 54010003  Failed to deliver the data to th smb error occurs
05/31/2011 10:05:21 ERROR | 67c355¢| 54010002  Failed to deliver the data to th smb error ocours
05/31/2011 10:05:00 INFO 40200112  Synchronization has succeede IP address : 132

5. Download the Error jobs (Serverless Edition Only)

@ Note )
[This step can be skipped if Server Edition is used. |

If your customer wants to save the image data of jobs stored in the MFPs’ error queue,
please download those to the PC’s HDD. Do not forget to download from all target MFPs
and to check both the Scan and Fax error queues.
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Procedure:

1. Open the Job Management screen, select the Error Queue, and then select a target
device (MFP) by clicking the displayed device name to open a device selection dialog.

2. Click the “Refresh” button to update the queue.

3. Select the jobs to download.

4. Click the “Download” button and input the file name.

Home Configuration Maintenance Settings Job Management

Job Queue | Error Queue |

Error Queue ‘ V-C3(192.168.0.10 ) ‘ Ll auto | € Refresh

[ Search | Display all |

= 1 logs

| Retry | |[Z] ErrorImage | |[Z, Download ||| [] Delete |

scan fax

Generation Date Last Refresh Date Job ID | Status MNo. of R Project Name User Name Document
V| 05/31/2011 10:05:19 05/321/2011 10:14;24 67c355¢ 4k error =] aa 20110531¢

6. Disable Secondary Delivery Server/Load Balance settings (Option)
@ Note )

This step can be skipped if Secondary Delivery Server/Load Balance Server is
not used.

If the customer is using Secondary Delivery Server /Load Balance settings, you need to
disable this setting before update the GlobalScan NX software. For the details, please
refer the Appendix D

7. Uninstall MS SharePoint Server Plug-in (Option)
@ Note )

[This step can be skipped if SharePoint Server Plug-in is not installed. |

If the customer is using MS SharePoint Server Plug-in, you need to uninstall this plug-in
before update the GlobalScan NX software. Uninstallation can be performed by [Start] >
[Control Panel] > [Add/Remove Programs]

@ Note )
e Uninstallation is required when upgrading the MS SharePoint Server plug-in
from v1.4.4 or earlier to v1.5.2.




8. Upgrade GlobalScan NX (PC application, v1.5.2)

1. Close all applications currently running on your computer.
2. Stop the GlobalScan Service.

4 Services

File Action Miew Help
4-->||@|@| [ T
% Services (Local)

#,  Services (Local)

GlobalScan Service Name ¢ | Description |status |
@Event Log Enables evert lo...  Started
Stop the service P Bllows files to be...

eplication
Restart the service c %

:  Started
Started
Started

Description:

GlobalScan Service Fause

Resumie 4
Restart Skartes

%Human Interface Devi,,
S Admin Service
APT CD-Burning CO.,

3. If you are using IIS as the web server, stop the IS Admin Service.
4. Insert the media containing the GlobalScan NX installer into the computer.

5. The GlobalScan NX Start screen displays.
« [f AutoRun does not start the installer, search for and run "RDLaunch.exe".
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6. Select the software you wish to install: Serverless Edition [AdminTool] or Server Edition

[Application & AdminTool].
7. The language selection screen appears.

8. Select the desired language, and then click [OK].

9. An alert will appear. Please click [Yes] to confirm overwrite installation.

X

Alert

Thiz product iz already installed.
Installation Folder: G¥Program Files¥GlobalScan
Are vou sure vou want to perfarm an installation overarite?

A

[ ‘e Ma
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10. A welcome screen is displayed.

11. Click [Next].

12. Read the licensing agreement, and then select “l accept...”.

13. Click [Next].

14. Enter a password to be used for the built-in user, and then click [Next].

15. Final confirmation for the overwrite installation appears.

alert x|

@ Are you sure you wankt to perform an installation overwrite?

16. Click [Yes] to start installation.
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9. Upgrade GlobalScan NX Option Plug-ins (if necessary)

@ Note )

[This step can be skipped if no option plug-in is installed. |

If your customer is using GSNX Option Plug-in(s), please update them to the newest
version. The newest versions are packaged with the GSNX installer.

To find installed plug-ins, please refer Appendix D

Installation Procedure

Suspend the Delivery Service.

GlobalScan NX ver1.5.2.0

2 Built-in Administrator

Configuration Maintenance Settings Job Management

System Profile
& E N
Home Configuration Maintenance Settings I
Maintenance System Control

System Control

Delivery Service Status  Running | Refresh

| Switch Delivery Service Status |

Please run the plug-in’s installer.

Device

During the installation, a confirmation window for the overwrite installation appears.

Please click [Yes] to continue the installation.
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Update System FW

Please update each MFP’s system firmware to the latest version. We recommend using
Remote Firmware Update if the customer has several models of MFPs in the office.
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GlobalScan NX SDK application Installation

1. Start "Remote Manager".
2. Open the Work state archive (filename.caz) that was saved after activating the GSNX

application.

(5 Note )

If your customer did not keep the Work state archive, please refer to Appendix E
before proceeding to step 3.

3. Click the "Device List" icon on the left panel.
4. Select the GSNX DSDK Application.

File Operations Yiew Help

~ ~

Errbedded Software Remote Manager
_) Device List
- o8| Product Key

[£4] Globalscan NX(336920832)
b Software

5. Select the "Operation"

Devicelist - Application: |GlobalScan NX(336920832)  ~ |

Address Description #of ...  Product Key Lock Code

@ 000000000 XX AL-C1 1 14150-10000-0.., 400-*1H3:Z
cav2i030b

menu and click "Uninstall...".

i3 Untitled - Embedded Software Remote Manager

Operations RTINS
>3 Add »
Delete Del -
Properties... Enter

it m .

Export...
g Install..

Get License. ..
Reissue License...
Store License...
Deactivate,..

Devicelist - Applicaion: |GlobalScan NX(336920832)  ~|

Address Description #of ... | Product Key Lock
W ocooooo ——— pLei o]
cav2i039ra

6. A confirmation message appears. Please ignore this message and click “Yes”.

Embedded Software Remote Manager E3

L Before uninstalling the application fram a device, the license code should be deactivated to prevent the praduct kesy
\_!-r) from becoming unusable.

Cne of the selected devices includes an active license code.,

Uninstall anwviway?
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7. The “?” icon appears next to the device in the Device list, indicating that the DSDK
Application has been properly uninstalled.

;g;f:jee.caz — Embedded Software Remote Manager

Eile  Operations  Miew Help

YO i g

ﬂ? R eR e A L L Device list — Application:  |GS-NX(336020832) =l
Device List _ _ _
% Product Key

Address | Description | #of A. | Product Key
@ e pet

] GE-NA(336920832)
¥ Software

8. Delete the GSNX application from the Software list.

o8 Add. ki
"%——1‘ Delete.. Del FM
Properties.. Enter ANAger Software list
% Product Key Software Name I Version | Tvpe
- Z4] G5-M¥I3369203320 = Globalscan M 1440 Application

-1py Software

9. Save the current status as a Work state archive (filename.caz).

e d | mportant
= This Work state archive will be used in order to install and reissue the
replacement GSNX application.
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Replacement Java VM card preparation

SD-Card Production Date Confirmation

Please confirm that the Year & Month on the provided SD Card’s label (this sample is
1005). The replacement’s Year & Month label should be 1107 or later.

Year & Month {YYIMM)
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Java VM card replacement
ACAUTION

* Unplug the main machine power cord before you do the following procedure.

_ i1 B
Remove the SD slot cover [A] for SD cards (& x 1).
Remove the existing VM card [B] from SD slot 2.

If the existing VM card [B] contains other SDK applications that do not require
activation, copy them to the new VM card.

d104i119a

w =

A
d104i204

4. Insert the new VM card [A] into SD card slot 2 so that the label faces the front of the
machine. Push it in slowly until you hear a click.

5. Attach the SD slot cover (& x 1).

6. Make sure that the machine recognizes the SDK application(s).
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GlobalScan NX SDK application Installation

(Continued)

1.

Open "Remote Manager".

£ Untitled - Embedded Software Remote Manager

Fle Operations Wiew Help
P &% e
K Erbedded Software Remote Manager

3, e

+ Product Key

Devicakt - Apphcatorr [[Selectan spphcatin]  v)
Address
Seftware

Description

#of ... | Product ey

<

Lock Cod

cav2i001

>

2. Open the Work state archive (filename.caz) which was saved after uninstalling the
GSNX application.

3. Select the "View" menu and click "Refresh.

4. Open the Device Properties window to verify that the Java VM has been installed and
is a supported version.

® Device List > Operations > Properties

® Device List > right-click the device > Properties

Address: XXX XXX XX
Model name: Aficio MP 5000
||.Java VM version: 4.08
Application list:
Application name | Version | Status
< >

cav2i096
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Adding a GSNX DSDK Application with the "Remote Manager"

5. Click the "Software" icon in the left panel.

i34 Untitled - Embedded Software Remote Manager

File Operations VYiew Help

P s | » P Al

Embedded Software Remote Manager

Software list

+ 2| Product Key

) oftware

Software Name

cav2i005a

Select the "Operations" menu and click "Add...".

1"“: lintitlad . Fmhaddad Saftuwara Ramnta Manager

File QoM View Help

lanager

+ Product Key

g Software

Software list

Software Name

7. Select a DSDK application zip and click the "Open" button.

cav2i006ra

Look in: l “w* Removable Disk [F:)

8336020832, 2ip

~ e BckE

Filename:  [336920832.zip

Files of type: IZIF’ files (*.zip)

™ Open as read-only

ﬂ Cancel

|
cav2i007

8. The software name and version number now appear in the "Software List".

File Operations Miew Help
e Gl i

. 1 T v ]|
4 | s P H Fodl

_ Embedded Software Remote Manager
Device List
e Product Key

Software

Software [zt

Werzinn | Type

sottware Hame

= GlobalScan N (N}

1620 Application |




Installing the DSDK Application on the Target Machine
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9.

10.

11.

Click the "Device List" icon to return to the Device List.

14 Untitled - Embedded Software Remote Manager
File Operations Yiew Help
> & 200 sl

Embedded Software Remote Manager
+

Device list - Application: I[Se1ec! an application)

-
+ Product Key Address Description # of Product Key
0 Software B 00000 XXK XX Alex C1 0
cav2i009a

Click the display name of the target machine on the "Device List".

u53 Untitled - Embedded Software Remote Manager
File Operations View Help
2» %%

Embedded Software Remote Manager
Device List

*-
+ =5 Product Key
35 Software

cav2i010a

Select the "Operations" menu and click "Install...".

A Comhaddad Cafbumen Do ate Manager

ile HeEGE View Help

- | Add »

£ Delete Del o e BT —

“3  Properties... Enter Device list - Application: ][Select an application) LI
l Export... Address Description #of ... ProductKey
E ! SOOC K XK XX

Uninstall...

Reissue License. ..
Store License...
Deactivate...

cav2i011a

installed.

. Select the software to be installed and the SD card slot where the VM card has been

For some DSDK applications, selecting the slot is not required (drop-down window

is iraied outi.

Select software to install and itz destination,

Software:

Software Mame

| Mersion
1520

Destination S0 slot 1 =]
ok |

Cancel
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13. Click the "OK" button.

14. Input the machine administrator’s user name and password.

Login

Enter device management authentication information.
Address: XXX XXX XXX XX
User: # admin{
Password: *
0K Cancel

cav2i013

15. Click the "OK" button.

16. Click the "OK" button after the installation completion screen has appeared.
Install X

Installing software on devices...

[=]
o

' cav2i014

Software installation completed.
Refresh the window after restarting the device to see the results.

ENREEENERNERNRRNEN|

cav2i015

(E Note )

If internet connection is unavailable at customer site, please save this device
status data as a Work state archive (filename.caz).
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Reissue a License for the GSNX DSDK Application

@~

(5 Note )

If you execute this step at a remote location, please perform the following steps

first:

1. Open "Remote Manager".

2. Open the Work state archive (filename.caz) which was saved after installing

the GSNX application.

Click the "Device List" icon on the left panel.
Click the target device in the "Device List" panel (make sure it is highlighted).

Select the DSDK Application which is already installed from the "Application" drop-
down window.

File Operations VYiew Help
b 0, 0p .o

5 Device List
- 8] Product Key

i software

Embedded Software Remote Manager

[£4] Globalscan Nx(336920832)

Device list - Application: |[Select an application) _v__|
Address Select an apphcation| milid m
OC X XHKH XX AL-C1 1
cav2i022b

Select the "Operation" menu and click "Reissue License...".

',;‘;.:,l ge.caz — Embedded Software Remote Manaeger

|

2§ &

Delete
Properties...

o

Export.

Ihetall..
Uninstall..

Ef

Giet License...

Beizsue License..

Store License...

Enter the "User ID and Password" registered with the activation server.

Eile BEEEWTEN Wiew Help

= Device list - Application: ](336920832) _:J
Address Description | #of A. | Produc
[ 1 W-C3

Click the "OK" button.
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Enter user authentication information to login to the
Activation Server.
User ID: |
Password: I
Reaqister User I 0K Cancel |

cav2i025
6. Click the "OK" button once the license has been reissued successfully.

Reizsue License m

The licenze has been izsued successfully.

ENNENENNENNNNNNNENEENEN o%

(E Note )

If you are not working at the customer’s site, please save the device status data
as a Work state archive (filename.caz). Then, visit the customer with this caz file
and proceed to the next step.
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Storing a License in a Target Machine
ONote )

If the previous operation was done at a remote location, please perform the

following steps first:

1. Open "Remote Manager".

2. Open the Work state archive (filename.caz) which was saved after reissuing
the license(s).

1. The picture below shows the following:
® The DSDK application has been installed in the target machine.
® The product license for the selected DSDK application has already been obtained
from the activation server.
2. Select the "Operation" menu item and click "Store License..." to store the product
license in the target machine.

# ©-%------ Remote Manager

| Ad ’

Delete Del
Properties... Enter Device list - Application: | N FIEEr]

Export... iy o
A 000 XXX XX XK AL-C1 1 14150-10000-0... 400-*1H3
Install...

Uninstall...

@ |

Fe il 4 m

Get License...
Reissue License...

Store License...

Deactivate. ..

cav2i027ra

3. The "Store License" process runs and displays a notification box when it is completed.
4. Click the "OK" button.

Store License @

License information has been stored with the selected devices.

IENEENENERNRNERNEN|

cav2i029

5. Make sure that the blue icon is displayed. It appears in the "Device list" when the
DSDK Application is activated (license for the selected application has been stored in
the target machine).
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File Operations View Help

P & % s

® gb“"*: fi';i‘““'s Remote Manager | pevice st - Appication: |GlobalScan NX(336920832)  v]
= 8] Product Key Address Description #of ... | Product Key Lock Code
(4] GlobalScan Nx(336920832) @ 000X X0 XX AL-C1 1 14150-10000-0... 400-*1H8:
&9 Software ?
cav2i030a

If any other icon except blue appears in the "Device list", check the icon appeared
in the "Device List". And then retry this procedure.

Cycle the power on the target device.
Save this device’s status as a Work state archive (filename.caz) after storing the

license and ask a customer to keep it.
Select the "File" menu item, and then "Exit" to close "Remote Manager".
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Other SDK application Installation

To install other SDK applications, please refer to the installation procedure provided for
that application.
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GlobalScan NX Synchronization

After the upgrade operation is finished, the devices must be synchronized with a Profile.

Procedure:

1. Access the Device List, which is located under the [Configuration] menu, [Device] tab.
2. Select the target MFP(s) to synchronize.

3. Click [Synchronize] and then [OK] to start the synchronization process.

Configuration Maintemance Seitings Tob: Managemenk
Sy sl Piolile Dewice
Device List
170 device
P Add # Edit W Delete | | Pratile Batch Configuration || g3 Synckranize

=T [Import Dewice List | S« Export Device List

{3  Refresh
IP Address/Host Mas  Device Name Pebon e Srreem Sine Frofile Mame Stulls.s
o 1B2dER 9.23s Imago MP 7500 WAAGA, Apcoinong Dept.ipd_4)
15, 168 4,243 ima@n MP 2550 A Anunang Capt.(pf_4)
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Confirmation of Upgrade

Once synchronization finishes, access a synchronized device to verify that the profile was
distributed correctly.

GlobalScan NX

Sel nd then a project.

AL linked test

LOCAL TEST

QL test GLTESTS AD

GLTESTZ

7 0CT 2008

System Status 14:35
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Appendix

A) Installed GlobalScan NX Edition Confirmation

Access Start>GlobalScan NX>Activation Tool

Wy s st b
é Internet Explorer & clobalfcan M Activation Toal
% Windows Lpdat L“;] Outlook Express k& GlobalScan M AdminTool
i PRemate Assistance @ GlobalScan M Manuals
;@ Symantec Endpoint Protection * &3 GlobalScan My S50 Setting Tool

@ Administrative Tools » |'§| Readme
ﬁi GlobalScan My 3 E] Readme {Barcode Plug-in}

Log OFf @ Shut Down

Idi%SI:art J @ g J |33 Windows Explarer vl %Services | 1@' bar-ove

All Brograms

If your customer is using a Server Edition, you will find the installed server edition in the
Activation List. If Serverless edition is installed, no entry appears in the Activation List.
(The sample below shows that Enterprise Server Edition has been installed).

GlobalScan Nx x|

Ackivation List

Glabalscan MY Barcode Plug-in Far Enterprise Server
Globalacan My Enkerprise Server

B) Secondary Delivery Server/Load Balance Server Confirmation

1) Check the System menu for the following two selections.
* If the settings are not available, these options are not used by that customer’s
environment.
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Home Configuration Maintenance Setting

System Profile Device

System Settings
o~

General Settings
) ServicesfFilters

b~
™
l w Authentication Profiles

Administrator
Job Settings
System Logs
Certificate

Replacement Table

| Secondary Delivery Server Settings |

| Load Balance Server Settings |

Kerberos Option

2) If the above settings are available, please check to see if your customer is actually
using them:

Secondary Delivery Server

Home Configuration Maintenance Settings

Profile Device

Secondary Delivery Server Settings

¥ ze Secandary Delivery Server

Secondary Delivery Server

4 http:/fsecondary ricohl 8B080/gsnx | Browse |

If a Secondary server is used, this setting needs to be removed before upgrading the
GlobalScan NX software. For the details, please refer to Appendix C.

Load Balance Server

m Configuration Maintenance Settings
Profile Device

Load Balance Server Settings

Add Load Balance Server

| &dd
Load Balance Member Server List | Previous Synchronization Date

| http:/192.168.0.10:8080/gsrx | 11/282010 10:17:59
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If a Load Balance server is used, this setting needs to be removed before upgrading the
GlobalScan NX software. For the details, please refer to Appendix C.

C) How to disable Secondary Server/Load Balance Server settings

@ Note )
This section also describes the basic process for upgrading the software installed
on any Secondary Delivery or Load Balance servers.

Secondary Delivery Server.

Uncheck the [Use Secondary Delivery Server] check box.

Hoime Configuration Malntenance Job Manages

Sy=bem Prufile Dewice

| Secondary Delivery Server Settings

.1{ Ilze Secondary Delivery Servar

Secondary Delivery Servar

[Procedure for upgrading GlobalScan NX Software]

1. Perform overwrite data installation on the Secondary server.

2 Perform overwrite data installation on the Primary server.

3. Add the Secondary server to the Primary server.

4. Synchronize the Primary Delivery Server with the Secondary Server.

Load Balance Server

Remove the Load Balance Server(s) from the Load Balance Member Server list on the
Primary server.

m Configuration Maintenance Settings Job M

System Profile Device

Load Balance Server Settings

&dd Load Balance Server

Add Delate

Load Balance Member Server List | Previous Synchronization Date

hitps:/f7 -~ "~~~ ":B443fgsn: 07/28/2008 14:46:06
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[Procedure for upgrading GlobalScan NX Software]

1. Perform overwrite data installation on the Load Balance server(s).

2. Perform overwrite data installation on the Primary server.

3. Add the Load Balance Server(s) to the Primary server.

4. Synchronize the Primary Delivery Server with the Load Balance Servers.

D) How to determine if Option Plug-ins are installed

Please run the GlobalScan NX Activation Tool.

\% Setvices ;@ Starkup > I -

é Internet Explorer & clobalscan M Activation Toal
% Windaws Lpdat Lﬁl Qutlook Express % GlobalScan My AdminT ool
. PRemote Assistance @ GlobalScan M Manuals

:@ Symantec Endpoint Protection * %3 GlobalScan My S50 Setting Tool
@ adrinistrative Tools » £] Readme
ﬁi GlobalScan M (2 E] Readme (Barcode Plug-in)

Log OFf @ Shut Diown

Itf_ﬂStart J @ ﬂ J |03 Windows Explorer -l %Services | 1@' bar-ovel

All Programs

The Activation List shows the installed & activated option plug-ins.
This sample image shows that the Barcode Plug-in has been installed.

GlobalScan NX ] x|

Ackivation List

Globalscan My Barcode Plug-in For Enterprise Server
Global3can My Enterprise Server

Qi |




PAGE: 34/36

E) Retrieving Device Information without a Work State Archive

1. Open "Remote Manager".

FxUntitled - Embedded Software Remole Manager
Fle Operstions View Help

P s e

[ Embedded Software Remote Manager - ————————————
*. Devica bt - Appication [[Select an appcation] |

+ 8 Produst Key Address Deserption #cf ... | Product Key Leck Cod
2 Software

< >

cav2i001
2. If any previous settings appear on the screen, open the "File" menu and select
"New" to refresh the screen.

Ctrias e Manager Device list - Application: ITE

5ave As... address

Exit

cav2i050a

3. Click the "Device List" icon on the left panel.

i Untitled - Embedded Software Remote Manager

P W I 18> % 8

3% Embedded Software Remote Manager Devicoliet - Appicatiorn:
p '
+ Product Key Address

10 Software

cav2i001a
4. Open the "Operation" menu and click "Add" > "Manual Input...”.
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= » Manual Input...
%_E : From File...
3 . Y vevicelist - Application: |
# o . Address I
Uninstall...
Get License...
Reissue License...
Store License...
Deactivate...
cav2i002ra

5. Enter the IP address or host name of the target machine and give a display name to

the target machine (Description).
6. Select to retrieve the installed application information (check box [A]), and then click

the "OK" button

Add Device - Manual Input @

Address: I

Description: I

[A] * I” Retrieve installed application information

0K Cancel

cav2i003



PAGE: 36/36

7. The IP address or host name and description of the target machine now appears in
the "Device List" panel.

i3 Untitled - Embedded Software Remote Manager
File Operations View Help

O 8w > sl

3% Embedded Software Remote Manager

+ gpmduttl(w Address ipti #of ...
in Software ‘9 N IH0C AKX AL-C1 0
cav2i004a

8. Click the "Product Key" icon on the left panel.
9. Select the GSNX DSDK application (highlighted).

i Untitled - Embedded Software Remote Manager
File Operations VYiew Help
@ | 02 % Al

% Embedded Software Remote Manager
Device List
=] Product Key

3D Software

Product key list - Applicatior

IProduct Key

cav2i017a
10 Select the "Operation" menu and click on "Add...".

emote Manager

Product key list - Application:

. Import...
- ; . Product Key

1 - 306920832)

i Software

cav2i018a

11.  Enter the "Product Key" which was used when activating the GSNX DSDK
application.

Add Product Key @

Product key:

OK Cancel |

cav2i020
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Reissued: 18-Oct-11

Model: XG-SD1 Date: 18-Dec-09 No.: RD420005e I
RTB Reissue
The items in bold italics have been corrected.
Subject: Release Note: GlobalScan NX (Lapnet Update Module) Prepared by: T.Nihei
From: MFP/Printer Tech Service Dept., 2nd Tech Service Sect.
Classification: |[] Troubleshooting [] Part information ] Action required
[] Mechanical [] Electrical [] Service manual revision
[] Paper path [] Transmit/receive [] Retrofit information
[] Product Safety X] Other (Firmware) X] Tier 2

This RTB has been issued to announce the module release information for the
GlobalScan NX.

This module is used for updating the GlobalScan NX SDK application from ver. 1.3.x
using Remote Manager.

Version Program No. Effective Date Availability of RFU
1.5.3.0 D4205181E October 2011 production -
1.5.2.0 D4205181D June 2011 production -
1.4.4.0 D4205181C December 2010 production -
1.4.2.0 D4205181B August 2010 production -
1.3.5.0 D4205181A April 2010 production -
1.3.4.1 D4205181 December 2009 production -

Note: Definition of Availability of RFU via @Remote
“Available”’: The firmware can be updated via RFU or SD card.
“Not available”: The firmware can only be updated via SD card.

Version

Modified Points or Symptom Corrected

1.5.3.0

1) Device Support Changes

- GlobalScan NX Serverless/Business Server/Enterprise Server Edition
V1.5.3.0 now supports the following devices:
Aficio SP 5200S/Aficio SP 5210SF/Aficio SP 5210SR/
Aficio MP 2352SP/Aficio MP 2852SP/Aficio MP 3352SP

2) Specification Changes

- A "Batch Download Logs" button has been added to the AdminTool's
Maintenance Settings. It is used to download different log types from the
AdminTool and the selected devices in a batch operation.

- NTLM authentication requests now use standard formatting. Previous
versions used a different formatting that could be authenticated even if the
time skew between GSNX and the authenticating server was great.

3) Fixed Issues

- Fixed: The Send to Email function does not send Notifications.

- Fixed: Wide format paper sizes would not be displayed on the Scan Size
tab after updating to V1.5.2.0.

- Fixed: Garbage/useless data would be included in imported Profiles. If a
single Profile went though multiple export-import cycles, it could
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Date: 18-Dec-09

No.: RD420005¢ |

Version

Modified Points or Symptom Corrected

eventually cause SC997 on synchronization.
- Fixed: Send to Folder can fail due to an out of memory error if a non-

domain controller responds to a request when using a NetBIOS user name

and the amount of scan data is large.

GW ver. Model Code Firmware Version Java VM Version
(System) (For Version-up)
05A B222/B224 B2215601S V1.70 B8615200Q Va2.15
models B230/B237 B2385601X V1.71
B246/B248/B249 B2475101W V3.05
D052/D053/D054 B2475101W V3.05
07A D009/D012 D0125751V V1.13 D4135765M V4.24.03
models D011/D013 D0135751V V1.13
D014/D015 D0145761N Vi1.12
D017/D019 D0195331P V1.17
DO018/D020 D0205331P V1.17
D046/D049 D0465749A v3.01 D5685765C V4.24.03
DO084/D085 D0855751B v1.01 D3775918E V4.24.03
D091/D092 D0925751B vi.01
08S D023/D025 D0255562V V1.24 D4135765M V4.24.03
models D027/D029 D0295562V V1.24
D038/D041 D0395521J V1.17
08A D062/D063/D065/D066 D0625572H V1.19 D4635200L V5.13.02
models
09S D067/D068/D069/D072 D0675530D v1.02 D4675200J V6.08.02
models
D115/D116 D1155530A V1.03
09A D081/D082 D0815760D V1.03 D0815792F V7.14.03
models D093/D094 D0935605A v3.01 D5065917D V7.14.03
108 D088/D089 D0895562L v3.01 D0895594E V7.14.03
models D086/D087 D0875562L Vv2.01
D104/D106 D1055730F V2.01 D1065743C V7.14.03
M022/M024/M026/M028 M0265771H Vv2.01 M0265738D V7.14.03
M052/M053/M054 M0525771C V1.03 M0525738A V7.13.03
D120/D121/D122/D139/ D1205530A V1.04 D1205565A V7.15.04
D140/D141

1.5.2.0

1) Device Support Changes
- GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.5.2.0
now supports the following device:
Aficio MP 201F/201SPF.

2) Specification Changes

- Users can now scan directly from the Metadata input screen.

- A new Scan Method, “Mixed Batch,” was added.

- Support for PDF/A when using the Send To E-mail's Page Divide function.

- LDAP Search results are now sorted.

- Support for the UPN (username@FQDN) is now available when using Active
Directory as the authentication method.

- Please note that if the UPN's FQDN and the domain stored in the AD
authentication profile do not match, the UPN's domain must be registered as a
trusted domain.

- NTLM v2 authentication is now supported for authenticating with a WebDAV
server.
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Version

Modified Points or Symptom Corrected

3) Fixed Issues

- Fixed: Projects requiring authentication cannot be logged in to on 4-line MFPs, if
the project was searched for by number.

- Fixed: Users could attempt to login to the SDK application during
synchronization. This would always fail, and is no longer possible.

- Fixed: E-mail addresses that GSNX failed to deliver to (due to an invalid IP
address for the SMTP server, etc.) are included in the Job Log's "Destination
Address" column.

- Fixed: A SFTP connection session remains even after the FTP delivery service
completes delivery.

- Fixed: Extra authentication information is included in imported profiles.

- If the extra information builds up, it could eventually reduce performance when
changing screens on the operation panel or SC997.

4) Other

- GSNX no longer writes data to the SD-Card as a part of log creation.

- When the "Cancel" button is used to cancel a job in the job queue, the cancelled
job is now moved to the error queue.

1.4.4.0 | 1) Device Support Changes
GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.4.4.0 now
supports the following devices:
- Aficio MP C300/C400/C4501/C5501/C3001/C3501/C2051/C2551/
W2401/W3601
The Aficio MP C300/C400 does have a limitation:
- GSNXv1.4.4.0 can only scan A4/Letter landscape documents on the Aficio
MP C300/C400.
2) Specification Changes
- Itis now possible to select the location where the output of the Metadata
Replacement filter is saved.
- SDK application version information and other data are now written to the GSNX
system log when the MFP starts up.
3) Fixed Issues
Fixed: Exported Replacement Tables that contain a comma in the Comparison
Target String are not imported correctly.
1.4.2.0 | ---- Changes from GlobalScan NX Lapnet Edition ver. 1.3.5.0 ----

1) Device Support Changes

GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.4.2.0 now supports
the following devices:

- Be-Ct

-—N-C3

2) Specification Changes

A hardware key can now be used to access the project search function on the Model Aficio
MP 171SPF/LD117SPF/917SPF.

The GlobalScan NX icon is now displayed on the Extended Featues screen.

The Activation Tool can now be used to activate the Kerberos option.

The Kerberos option is now supported for use with GSNX Serverless.
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Version

Modified Points or Symptom Corrected

“Passwordless Authentication” (Active Directory and LDAP) has been added as an
authentication method.

A confirmation dialogue now appears when a scan job completes.

Wide format paper sizes have been added to scan settings menu.

“Continue flow without performing replacement” has been added to the “Select Action when
Table Data does not Match” menu.

A log entry is recorded in the Syslog when the metadata replacement filter does not match.
The tag “JIS” has been added to the “Bx” paper size.(eg; B4 JIS)

The dayofweek and generationDate(Local) metadata fields have been added.

The Error Queue now supports batch downloading of error images.

The IP address field of the device list now links to each registered device's Web Image
Monitor.

A Plug-in Information page has been added to the AdminTool.

“Logical Division (Join Automatically)” has been added as an e-mail attachment Size Divide
option.

Support for PDF/A has been added to the PDF Converter.

The user's home folder and email address can now be retrieved from an authentication server
that is not used for the authentication profile.

The total number of entries for the replacement table has been raised from 1000 to 2000.
New fax templates for fax delivery based on day of the week or time are available for
installation with the other project templates.

3) Fixed Issues

Fixed: When logging in to the project without a password, delivery fails if scan to home folder
is used.

Fixed: The Operation panel locks as a result of logging out via the logout key while a dialog
box is displayed.

Fixed: LDAP server address search fails if the DN of the login user is required when
attempting email delivery.

Fixed: The Start key turns red and cannot be pressed if the project only contains Flow
Redirect and was restored from a profile created by GSNX v1.3.4.0 or earlier.

Fixed: The Start key would turn green when the error dialog that appears when the same
password is input as both the user and master passwords for the PDF conversion filter is
closed.

1.3.5.0

1) Device Support Changes
GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.3.5 now supports
the following devices:
- Model V-C3
2) Specification Changes
Support for Windows 7 Ultimate/Enterprise/Professional Edition has been added.
However, Windows 7 is only supported by GlobalScan NX Serverless Edition V1.3.5.0.
3) Fixed Issues
Fixed: A communication error occurs while using GlobalScan NX's AdminTool.

1.3.4.1

1) Specification Changes
The name and description shown on the MFP's Extended Feature Settings screen has been
changed to the following:
- Name: “GS-NX”
(This name is also displayed when the MFP function button assigned to GSNX is pressed.)
- Description: “GlobalScan NX (L)”

2) Fixed Issues
Fixed: When restoring backup data created by GSNX Serverless Edition on GSNX Server
Edition, PDF user/master passwords stored in the PDF Converter Plug-in will not be restored.

Fixed: Home folders cannot be selected as a destination for projects that add a new Send to Folder
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Modified Points or Symptom Corrected

Plug-in when “Enable Send to Home Folder” is activated by default in the System Settings or Profile

Properties.
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Model: GlobalScan NX Date: 02-Sept-11 No.: RD420012a |
RTB Reissue
The items in bold italics have been corrected.
Subject: GlobalScan NX Update Guide Prepared by: Masaaki Horikoshi
From: Global Technology Support Department
Classification: | Troubleshooting [] Part information X Action required
] Mechanical ] Electrical [IService manual revision
[] Paper path [] Transmit/receive ] Retrofit information
[] Product Safety [] Other ( ) [] Tier2

This RTB has been issued to announce the release of the GlobalScan NX update guide for
the MIF replacement required by the SD-Card failure and potential data loss issue.

Note
This guide has been prepared for RAC, RE and RCN. It is not intended for use by RA.
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Global Marketing Group
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Abstract

Notification

This document is written based on the understanding that GSNX is already installed and
working. As described in the “GlobalScan NX Installation/Uninstallation/Update Guide”,
this means:

. Any required Hardware Options are attached (Optional Memory, etc.)

e The Heap/Stack Size settings configured correctly:

GlobalScan NX | CAP ELP-NX | Required Heap Size
Yes - - Default Setting
Yes Yes - 16 MB
Yes Yes Yes 16 MB

e The Auto Off Timer is set to 5 minutes or longer.

Preparation

Please review the customer’s environment before starting the update. Information that
should be reviewed and confirmed is as follows:
Customer Models
- Java VM cards
- Latest System FW
GSNX Edition (Server/Serverless)
FAX function is used or not.
Other installed SDK applications
- If the customer uses an SDK application that requires activation (such as CAP),
please prepare the object and a new product key in advance.
- Please confirm that the installed version of CAP is compatible with GSNX. For
details, refer to the following table:

CAP V14 CAP V2.0
GlobalScan NX V1.5 OK OK

@ Note )

e If you already have the customer’s details, and are sure there are no mistakes,
you can perform the “New Java VM card preparation” section at your office.
This would reduce the amount of time spent at the customer site.
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Procedure (Outline)

1.

2.
3.

N O~

(If fax function is used) change the Reception File Setting from Store to Print in the
Facsimile Features menu.
Update the GSNX PC application and optional plug-ins.
Replace the VM card. There are 2 procedures for installing the GSNX SDK application:
A: Write the SDK application to the new Java VM SD card in advance.
B: Use Remote Manager after replacement.
Also, install other SDK applications which don’t require activation at this time.

@ Note )

This step can be performed before visiting the customer (see the “preparation”

section).

Install the GSNX SDK application.

Install other SDK applications which require activation.

Synchronize the GSNX profiles with the devices.

Confirm the MFPs profile is distributed properly.

(If fax function is used) restore the Reception File Setting from Print to Store in the
Facsimile Features menu.

@ Note )

To avoid unexpected trouble, do not synchronize the PC application with the

SDK application until after the SDK application is upgraded.

@ Note )

If you are al.ready familiar with the procedures required by the above steps, you

do not need to continue using this document.
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Use the following versions for Field Replacement for SD card corruption:

PC application: V1.5.4 or V1.5.4.2. (Standard product module)
SDK application: V1.5.4.4 (non activation module)

Released Non-activation Embedded (SDK) Modules & Server Compatibility:
V1.5.2 and V1.5.3 were released for initial field replacement for the SD-card corruption issue.
V1.5.4.4 is for the remaining field replacements.
V1.5.4.2 SDK application is compatible with PC application V1.5.2 and V1.5.3. However,
supported functionality is based on the PC application version. This means that new functionality
added in v1.5.4 is not available if the PC application is V1.5.2 and V1.5.3.

Embedded Module (SDK application)
V1.5.2 V1.5.3 V1.5.4.2
(Do not use) | (Do not use)
Corresponding Stendard V1.5.2 V1.5.3 V1.5.4.2
Product Version
Product ID 336921056 336921056 | 336920832

Server V1.5.2 YES NO YES
Module V1.5.3 YES YES YES
(PC V1.5.4 YES YES YES
application) V1.5.4.2 YES YES YES

Note1: V1.5.2 is the initial release of V1.5.x.

Note2: V1.5.4 and V1.5.4.2 of the SDK application are not released in non-activated versions.

Note3: V1.5.4 of the PC application is released as a full installer (supports both new and upgrade installations).
Note4: V1.5.4.2 of the PC application is released only as an update program (upgrade installation only).
Note5: V1.5.4 and V1.5.4.2 of the PC application have no functional differences.



Non-activation V1.5.2/V1.5.3 Product ID issue:
A problem has been discovered in the non-activation version of V1.5.2 and V1.5.3.

Note
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See the “Problem: Directly moving from a 3rd party application to GSNX
may not work.” section for problem details and required action.

How to Select Replacement Modules:
- For ongoing replacement activities, please use V1.5.4.x for replacement, as described

above.

- If the Product ID issue is occurs, update the SDK application to V1.5.4.2 (non-activation).
- Standard (activation required) v1.5.x doesn’t require further replacement.

, Replacement
GRS Product ID | Affected By | [Jeplacement | = p  edded
Version Server Module "
odule
V1.4.4 SD Card V1.5.4
or earlier Standard 336920832 Corruption V1.5.4.2 Vil
Standard 336920832 None Not Required o o_t
Required
vi.s5.2 Non- Product ID
Activation 336921056 issue Not Required V1.5.4.2
. Not
V1.5.3 Standard 336920832 None Not Required Required
Non- Product ID .
Activation 336921056 issue Not Required V1.5.4.2
V1.5.4 , Not
V1.5.4.2 Standard 336920832 None Not Required Required
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Target MFP models and supported VM versions

For each MFP model, make sure to install the following or newer VM version.

Firmware
Model Code Java VM Parts Number Version (System) Version
B222/B224 B8619900 V2.15 B2215601S V1.70
B230/B237 B8619900 V2.15 B2385601X V1.71
B246/B248/B249 B8619900 V2.15 B2475101W V3.05
D052/D053/D054 B8619900 V2.15 B2475101W V3.05
D009/D012 D3779900 V4.23 D0125751V V1.13
D011/D013 D3779900 V4.23 D0135751V V1.13
D014/D015 D3779900 V4.23 D0145761N V1.12
D017/D019 D3779900 V4.23 D0195331P V1.17
D018/D020 D3779900 V4.23 D0205331P V1.17
D046/D049 D3779900 V4.23 D0465749A V3.01
D084/D085 D3779900 V4.23 D0855751B V1.01
D091/D092 D3779900 V4.23 D0925751B V1.01
D023/D025 D4309900 V4.23 D0255562V V1.24
D027/D029 D4309900 V4.23 D0295562V V1.24
D038/D041 D4309900 V4.23 D0395521J V1.17
D062/D063/D065/D066 | D4639900 V5.12 D0625572H V1.19
D067/D068/D069/D072 | D4679900 V6.07 D0675530D V1.02
D115 D4679900 V6.07 D1155530A V1.03
D081/D082 D0819901 V7.09.3 D0815760D V1.03
D093/D094 D5069900 V7.09.3 D0935605A V3.01
D088/D089 D0899900 V7.09.3 D0895562J V2.05
D086/D087 D0899900 V7.09.3 D0875562H V1.05
D104/D106 D1069900 V7.09.3 D1055730D V1.02
M022/M024/M026/M028 | M0269900 V7.09.3 M0265771F V1.04
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GlobalScan NX PC Software Upgrade

Pre-Check

Before upgrading the PC Software, please check the following:

#1. Is Serverless Edition installed? [Yes, No]

#1.1. If Yes, does the customer want the job/error log saved? [Yes, No]
#2. Is the Load Balance or Secondary Delivery Server function used? [Yes, No]
#3. Are any Optional Plug-ins installed? [Yes, NO]

#3.1. If Yes, is the MS SharePoint Server plug-in installed? [Yes, No]

@ Note )
Try to get the answers from the customer. If this is not possible, check them
yourself using the procedures described in Appendix A-D.

Procedure

@ Note )

ISteps 1, 2, 3 and 8 (in Bold) are mandatory. The other steps are optional.

1. Perform a Manual Backup (for safety).

2. Download a Backup File (for safety).

3. Export a Device List (for safety).

(If #1.1 is “Yes”) export the System Log and Job Log.

(If #1.1 is “Yes”) download the Error jobs.

(If #2 is “Yes”) disable the Secondary Delivery Server/Load Balance settings.
(If #3.1 is “Yes”) uninstall the MS SharePoint Server Plug-in.

Upgrade the GlobalScan NX Software.

4,
5.
6.
7.
8.
9. (If #3 is “Yes”) upgrade the GlobalScan NX Optional Plug-ins.
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1. Perform a Manual Backup (for safety)

1. The Backup menu is available from the [Maintenance] tab of the [Maintenance Settings]
screen.

GlobalScan NX

e
Homie Configuration Maintenance Settings Job Management Logs

Maintenance System Control

2 Built-in Administrater | Logout

Maintenance

Task in Process

k]

SlotNe. Date/Time [ comment
L Blark [
= Blank
3 glank
<+ Elank
5 Blank
& Blank
7 Elank
= Blgnlf

2. Select (highlight) a slot.

3. Click [Backup].

Scheduled Backup

e Add rd r

Sohedule M. Backup Start Datef Bachup ot Ne. Sackup Desoription Frevisus Enecwtl Previeus R Cenmsest

4. A message will appear with a [Comment] field. Enter a comment if desired, and then
click [OK]. Another message will be displayed indicating that the Backup operation was
successful.

5. Click [OK]. The newly-created backup file will have been added to the list.

Slot Wo. Drate/Time Comment =
1 06/09/2009 17:41:56 June 1 3
2 Hlank [‘

3 Blank
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2. Download a Backup File (for safety)

1. Select the backup data you created in the previous section.

2. Click [Download].

You can set a password to protect the backup file. If entered, this password will be
required when the backup file is uploaded. Only alphanumeric characters can be used for
the password.

3. If using a password, please enter it twice.

Download

@ Confirm

Do you want to download?

Password |

Confirm Password |

- Cancel |

4. Save the backup file to the desired location.
A message will appear indicating that the download operation was successful.

3. Export the Device List (for safety)

Please export the current device list.
To export the device list, please click the “Export Device List” button after selecting all
registered devices.

m Maintenance Settings Job Management

System Profile Device

Device List
I7O device

[@ Add | | 4 Edit || Delete | |EE Profile Batch Configuration |lﬁ::> Synchronize |

|+[Z| Import Device List | |[Z}+ Export Device List |

IP Address/fHost Ni¢ Device Name Model Screen Size Profile Mame
P e e e W23 Aficio MP C7501 WG bartest(pf_1)
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4. Export the System Log and Job Log (Serverless Edition Only)

@ Note )

[This step can be skipped if Server Edition is used. |

If your customer wants to save the MFPs’ Job and System Logs, please export them. Do
not forget to export them from all target MFPs.

Procedure:
1. Open the Log screen, select the desired log, and then select a target device (MFP) by
clicking the displayed device name to open a device selection dialog.

H “ »
2. Click the “Refresh” button to update the log.
3. Click the Export button and input a file name.
Home Configuration Maintenance Settings Job Management
| Job Log System Log |
System Log | V-C3("~~ "~~.166.118) | [ auto [€ Refresh
| Search | | Display all |
A
| T Delete All |||[Z}» Export | 5 logs
Recorded Date/Timev  Level Job ID  Error Code Error Message Action Message Remarks
05/31,/2011 10:14:24 ERROR 6703555 54010003  Failed to deliver the data to th smb error ocours
05/31/2011 10:11:23 ERROR | 67c355t| 54010002  Failed to deliver the data to th smb error ococurs
05/31/2011 10:08:22 ERROR | 67c355%5 54010003  Failed to deliver the data to th smb error occurs
05/31/2011 10:05:21 ERROR | 67c355¢| 54010002  Failed to deliver the data to th smb error ocours
05/31/2011 10:05:00 INFO 40200112  Synchronization has succeede IP address : 132

5. Download the Error jobs (Serverless Edition Only)

@ Note )

[This step can be skipped if Server Edition is used. |

If your customer wants to save the image data of jobs stored in the MFPs’ error queue,
please download those to the PC’s HDD. Do not forget to download from all target MFPs
and to check both the Scan and Fax error queues.

Procedure:

1. Open the Job Management screen, select the Error Queue, and then select a target
device (MFP) by clicking the displayed device name to open a device selection dialog.

2. Click the “Refresh” button to update the queue.

3. Select the jobs to download.

4. Click the “Download” button and input the file name.
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Configuration Maintenance Settings Job Management

Job Queue | Error Queue |
Error Queue | V-C3(192.168.0.10 ) | L1 auto
| search || Display all |
I 1 logs

| Retry | |[Z] ErrorImage | |2} Download ||| ] Delete |

scan fax

Generation Date Last Refresh Date Job ID | Status MNo. of R Project Name User Name Document
v 05/31/2011 10:05:19 05/31/2011 10:14;24 67c355C & error =] aa 20110531¢C

6. Disable Secondary Delivery Server/Load Balance settings (Option)
@ Note )

This step can be skipped if Secondary Delivery Server/Load Balance Server is
not used.

If the customer is using Secondary Delivery Server /Load Balance settings, you need to
disable this setting before update the GlobalScan NX software. For the details, please
refer the Appendix D

7. Uninstall MS SharePoint Server Plug-in (Option)
@ Note )

[This step can be skipped if SharePoint Server Plug-in is not installed. |

If the customer is using MS SharePoint Server Plug-in, you need to uninstall this plug-in
before update the GlobalScan NX software. Uninstallation can be performed by [Start] >
[Control Panel] > [Add/Remove Programs]

@ Note )

e Uninstallation is required when upgrading the MS SharePoint Server plug-in
from v1.4.4 or earlier to v1.5.x




8. Upgrade GlobalScan NX (PC application)

1. Close all applications currently running on your computer.
2. Stop the GlobalScan Service.

*, Services

File Action Wiew Help
e |EEFEDR(2E > 50w
% Services (Local)

%, Services (Local)

GlobalScan Service Name  #

| Skatus
Started

| Description
Enables event lo..,

Event Log
Stop the service
Restart the service

%File Replication

Allows files ko be...
... 8

Pause

Resumie

Restart

al3can Service Started
Started

Started

“gnHelp and Support

S HTTP 550

%Human Interface Devi.,
B 15 Adrmin Service
MAPT CD-Burning CO, .

Description:
Global3can Service

Started

3. If you are using IIS as the web server, stop the IS Admin Service.

4. Insert the media containing the GlobalScan NX installer into the computer.

5. The GlobalScan NX Start screen displays.
« [f AutoRun does not start the installer, search for and run "RDLaunch.exe".
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6. Select the software you wish to install: Serverless Edition [AdminTool] or Server Edition

[Application & AdminTool].
7. The language selection screen appears.

8. Select the desired language, and then click [OK].

9. An alert will appear. Please click [Yes] to confirm overwrite installation.

E3

—_

fAlert

Thig product iz already installed.
Installation Folder: C#Program Files¥Globalscan
Are wou sure vou want to perform an installation overwnrite?

| |

[ e Mo
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10. A welcome screen is displayed.

11. Click [Next].

12. Read the licensing agreement, and then select “l accept...”.

13. Click [Next].

14. Enter a password to be used for the built-in user, and then click [Next].

15. Final confirmation for the overwrite installation appears.

alert x|

@ Are you sure you wankt to perform an installation overwrite?

16. Click [Yes] to start installation.
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9. Upgrade GlobalScan NX Option Plug-ins (if necessary)

@ Note )

[This step can be skipped if no option plug-in is installed. |

If your customer is using GSNX Option Plug-in(s), please update them to the newest
version. The newest versions are packaged with the GSNX installer.

To find installed plug-ins, please refer Appendix D

Installation Procedure

Suspend the Delivery Service.

GlobalScan NX ver1.5.2.0

2 Built-in Administrator

Configuration Maintenance Settings Job Management

System Profile
& E N
Home Configuration Maintenance Settings I
Maintenance System Control

System Control

Delivery Service Status  Running | Refresh

| Switch Delivery Service Status |

Please run the plug-in’s installer.

Device

During the installation, a confirmation window for the overwrite installation appears.

Please click [Yes] to continue the installation.
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Update System FW

Please update each MFP’s system firmware to the latest version. We recommend using
Remote Firmware Update if the customer has several models of MFPs in the office.
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Replacement Java VM card preparation

GlobalScan NX (without Activation)

As GSNX non activation module for MIF replacement doesn’t require activation, simply
copying the GSNX SDK application to a Java VM card will work. If possible, we
recommend preparing the required VM cards in advance (Procedure A; 4-line LCDs
are not supported).

Otherwise, please use RemoteManager (Procedure B).

Copy the GSNX SDK application to the Java VM card (Procedure A):
@ Note )

e This method is not usable with 4-line LCD models due to the limited display
capabilities.

. Copy the GlobalScan NX SDK application to your PC.

2. Unzip the GlobalScan NX SDK application file creates the “336920832” folder and

“package.xml” file.
€1336920832]

—

| package.xml

3. Insert a VM card to a Panasonic SD Card Reader/Writer that is connected to the PC.
Open the VM card and copy the “336920832" folder to the "dist" folder (sdk/dsdk/dist)
of the VM card, as shown below.

SR A PPL COMMT (E:D

) ewinitd

= module

- 5 sdk

16974092
i ap
] COmmon
= d=dk

# [ server T se00mam

4. Remove the VM card from the Panasonic SD Card Reader Writer.

F

I

Move other SDK applications (without Activation)

If the customer uses other SDK applications which do not require activation, those
applications should work simply by copying from the existing VM card to the new VM
card. See each application’s installation guide for details.
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SD-Card Production Date Confirmation

Please confirm that the Year & Month on the provided SD Card’s label (this sample is
1005). The replacement’s Year & Month label should be 1107 or later.

Year & Month [YYMM)
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Java VM card replacement
ACAUTION

= Unplug the main machine power cord before you do the following procedure.
——|- i =

_ i1 B
Remove the SD slot cover [A] for SD cards (& x 1).
Remove the existing VM card [B] from SD slot 2.

If the existing VM card [B] contains other SDK applications that do not require
activation, copy them to the new VM card.

d104i119a

w =

A
d104i204

4. Insert the new VM card [A] into SD card slot 2 so that the label faces the front of the
machine. Push it in slowly until you hear a click.

5. Attach the SD slot cover (& x 1).

6. Make sure that the machine recognizes the SDK application(s).
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GlobalScan NX SDK application Installation

Installation (Procedure A)

1. Turn on the target machine, and Java VM will install itself.
2. Login to the target machine as an administrator.
3. Press the "User Tools" key, and then push the "Extended Feature Settings" button on

the operation panel.

€> User Tools / Counter / Inquiry

Copier / Document Server 53 e
@ o ims B s

ol
(T svstem settines

@B Facsimile Features E] Inauiry
.! Printer Features
é Scanner Features

@ Counter u: Extendad Feature Settings ‘

4. Next, select "Extended Feature Settings".

== Extended Feature Setting Menu

Extended Feature Settings JwvaTH Flatform

5. Select the "Install" tab, followed by "SD Card".

==, Extended Feature Settings

[ sawe \(RR [ arerge \[ Extened | [Administrator
ato | y \ woe || Exten \ | Administrater |
Setting J stall \'\ Unirstall | Allocation \- Feature Info "1 Tools \

Select a source media, then select extended feature(s) to mstall,

Wedia Tywe Ftended Frature Name Description Version Source

S0 Card Type=)  GlobalScan MY 1.544 50 Card Slot 2

Ty JavaTM Platform  Extended Feature(la,.. 4.07 50 Card Slot 2
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6. Select GlobalScan NX, and select the service slot (the actual slot will vary depending
on the machine) and “Auto Start”. By selecting “Auto Start”, the GlobalScan NX service
automatically starts-up after completing the activation process and rebooting the
machine. Press "Next" to continue this installation procedure.

Exctended Feature Installation

Select imstallation target and startup method,

Wimtall to
Meachine HOO

S0 Card Slot 1 SD Card Slot 2

PStartup Method

Auto Start Do not Auto Start

(iNote )

e Do not install “GlobalScan NX” to the HDD of the target machine.

e Switching GlobalScan NX manually between "Stop" and "Starting-up" on the
operation panel might cause the device to run out of memory. So, we
recommend using Auto Start.

7. Verify that the displayed SDK application name and version number are correct.

Extended Feature Info Exit
The following extendsd feature has been installed,
Exctended Feature Mame: B5-NK (NI PProduct D 336920852
Pliezcription GlobalScan M (N}
BVersicn 1.5.4.2 - duto Start: e o
P installation Target S0 Card Slot 2
Pendor:
PContact: TEL:

Fa

E-mail:

(5 Note )

e If the displayed SDK application is not what you want to install, verify that the
contents of the VM card are correct and retry this installation.

8. Press "OK" to complete this installation.

9. Reboot the MFP. If using Auto Start (as recommended), GlobalScan NX will start up

after the reboot is finished.

ONote )

1.Both Web Image Monitor and the MFP’s Extended Feature Settings screen
may display the status of GlobalScan NX as “Suspend”. This is equivalent to
“Starting Up” and is normal behavior.
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Installation Method (Procedure B)
C?Important )

e Make sure to turn off the Auto Off Timer for the duration of the
installation process. If the timer is left on, the machine will enter Auto Off
Mode while the installation is in progress, causing the installation to fail.

1. Open "Remote Manager".

£ Untitled - Embedded Software Remote Manager

T = ————————
H Devica it - Applcaion: [[Select an application] =
. Product Key Address. Descriphion #of ... | Product Key Lock Cod

< >

cav2i001
2. If a previous setting is displayed, open the "File" and select "New" to refresh the screen.
= Make sure that the PC running the "Remote Manager" is able to connect to the
target machine via the network.
= Check the status of the target machine(s).

ArHn-asi-4 r—L- 444 Goftware Remote Manager

IZIE Operations View H@p

Save Device list - Application: ITE

Save As..,

Address

Exit

cav2i050a

3. Click the "Device List" icon on the left window to ensure you are working on a Device
List (it will be highlighted).
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lle Operations View Help

W & 18> % 8

3% Embedded Software Remote Manager D eico bR A st
p '
+ 5| Product Key Address
Software
cav2i001a

4. Open the "Operation" menu item and click "Add" > "Manual Input...".

> I BT

From File...

Uninstall. ..

Get License...
Reissue License. .,
Store License.. .
Deactivate. ..

cavzi002ra

5. Enter the IP address or host name and a display name (Description) for the target
machine. For segment numbers under 100, do not include a “0” before the number, as
an error will occur.

Add Device - Manual Input =

Address: I

Description: I

[A] = |~ Retiieve installed application information

0K Cancel

cav2i003
= The display name is the name shown in the "Device List" window of this utility.
= You can register multiple machines to the "Device List" with this manual input.
6. Check box [A] to collect application information from the device, and then click the "OK"
button.
= Application information can be viewed by checking the device properties after
registration is complete.
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7. The IP address or host name and description of the target machine are displayed in the
"Device List" window.

i Untitled - Embedded Software Remote Manager
File Operations View Help

‘0');4? h & S O 6\

# Embedded Software Remote Manager

~ |

&

+ 5| Product Key Address Description #of... Pro

iD Software ‘Q XXX XXX XXX.XX Alex C1 i}
cav2i004a

8. Open the Device Properties window to verify that the Java VM has been installed and
is a supported version.
= Device List > Operations > Properties
= Device List > right-click the device > Properties

Address: XXX XXX, XXX XX
Model name: Aficio MP 5000
||Java VM version: 4.08

Application list:

Application name ] Version I Status

< >

cav2i096

Adding a DSDK Application with the "Remote Manager"

9. Click the "Software" icon in the left window to work on Software (it will be highlighted).
i3 Untitled - Embedded Software Remote Manager
File Operations Yiew Help

S b, h LA Il o ..zl

% Embedded Software Remote Manager

Software list

- Coot

+ E Product Key Software Name

g Software

cav2i005a

10.Select the "Operations" menu item and click "Add...".
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i34 1 Intitlad - Fmhaddad €nfturara Ramata Manager

File QoD View Help
: E . ranager Software list

+ Product Key Software Name

= sortare|

cav2i006ra
11.Select a DSDK application zip (product-ID.zip) and click the "Open" button.

Open E]
Look in: @ Desktop ﬂ EF ER-

gsnx-1.5.4.2_eu_nofck,zip
< b
File hame: |gsmH 5.4.2_eu_nodctzip Open
Files of type:  [ZIP files [*.2ip) | Cancel

[” Open as read-only

12.The software name and version number now appear in the "Software List".

53 Untitled - Embedded Software Remote Manager
File Operations View Help

&

Embedded Software Remaote Manager

T Software list
Device Lisk
+ E Saftware Name Wersion | Type
) safhware =Globalscan i (N) 1.54.2 application

Installing the DSDK Application on the Target Machine

13.Click the "Device List" icon to return to the Device List (it will be highlighted).

ng Untitled - Embedded Software Remote Manager
File Operations Yiew Help

23 s 00 4l

e Embeddd Sftware Remote Manager Device list - Application: IISelect an application) LI
&1 Device List
+ Product Key Address Description #of ...  Product Key
¥ Software D RXCXXXXXKNK alex C1 0
cav2i009a

14.Click the display name of the target machine on the "Device List".

= Multiple devices can be selected.



#52 Untitled - Embedded Software Remote Manager
File Operations View Help

Pw e > sl

Device list - Application: |[Selecl an application) L]

Embedded Software Remote Manager
*- Device List

+ Product Key
3P Software

cav2i010a

- | Add >

£ Delete Del " — — —

“3  Properties... Enter Device list - Application: I[Select an application) LI
! Export... Address Description #of ... ProductKey
E ! 20K OO XOOK XX

Uninstall...

Reissue License. ..
Store License...
Deactivate...

cav2i011a
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16. Select the software to be installed and the SD card slot where the VM card has been

installed.

= For some DSDK applications, selecting the slot is not required (drop-down

window is iraied outi.

Select software ta inztall and itz destination.

Software:

Saftware Name | Yersion | Type

1542 Application

[~
|

=l
Ok | Cancel

17.Click the "OK" button.

18.Input the machine administrator’s user name and password.
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Login @
Enter device management authentication information.

Address: XXX XX XXAX XX
User: * |admr{

Password: * |

0K | Cancel |

cav2i013

19.Click the "OK" button.

20.Click the "OK" button after the installation completion screen has appeared.

Installing software on devices...

[=]
™

' cav2i014

Software installation completed.
Refresh the window after restarting the device to see the results.

ENNNEENENNERNRRNEN|

cav2i015

21.Select the target machine on the Device List.
22.Select the "View" menu item and click "Refresh.

Noe
= (Click the "Refresh All" if you have installed software to multiple target machines.
This refreshes all machines listed in the "Device List".

£ Untitled - Embedded Software Remote Manager
File Operations RITN Help

% Embedded Sofl Refresh All r LI

Device list - lication: | (Select an application
%=, Device List Aon [ Pe )
+ Product Key Address Description #of ... | Product Key
3P Software ‘g XO0X. XXX XXX XX Alex C1 0
cav2i016a

23.Select a device.
24.Select an installed DSDK Application from the “Application” drop-down window.

= In this example, “GlobalScan NX” is selected.
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214 Untitled - Embedded Software Remote Manager

File Operations View Help

w4l

Embedded Software Remote Manager

¥ Device List
+ %Product Key

Software

Device list - Application;

| [Select an application)

I~ |

r -
Select an application|

Address

OOC XX KKK XX

GlobalScan NX(336920832)
Alex C1

Product Key

cav2i022a

25.The white lamp icon indicates that the DSDK application is appropriately installed.

i# Untitled - Embedded Software Remote Manager

File Operations Yiew Help

Make sure that the lock code appears in the Lock Code column.

2w B> sl
Embedded Software Remote Manager | yice it - Application: | GlobalScan NX(336320832) _~|
= Device List
+ Product Key Address | Description #of ... Product Key Lock Code
[ Software @ xxxxxx. 2000, X% Alex C1 1 400-*1HB2CTY...

cav2i055

26. Verify that the version of the installed SDK application is correct.
= Device List > Operations > Properties

= Device List > riﬁht-click the device > Properties

Software:

Select software to install and itz destination.

Software Mame

| Yersion

| Type

GlobalScan M [M]

G

1.5.4.2

Application

|
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Other SDK application Installation

To install other SDK applications, please refer to the installation procedure provided for
that application.
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GlobalScan NX Synchronization

After the upgrade operation is finished, the devices must be synchronized with a Profile.

Procedure:

1. Access the Device List, which is located under the [Configuration] menu, [Device] tab.
2. Select the target MFP(s) to synchronize.

3. Click [Synchronize] and then [OK] to start the synchronization process.

Configuration Maintemance Seitings Tob: Managemenk
Sy sl Piolile Dewice
Device List
170 device
P Add # Edit W Delete | | Pratile Batch Configuration || g3 Synckranize

=T [Import Dewice List | S« Export Device List

{3  Refresh
IP Address/Host Mas  Device Name Pebon e Srreem Sine Frofile Mame Stulls.s
o 1B2dER 9.23s Imago MP 7500 WAAGA, Apcoinong Dept.ipd_4)
15, 168 4,243 ima@n MP 2550 A Anunang Capt.(pf_4)
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Confirmation of Upgrade

Once synchronization finishes, access a synchronized device to verify that the profile was
distributed correctly.

Job Log

GlobalScan NX Lanuage

Sel nd then a project.

QL linked test

LOCAL TEST

@l test GLTEST3 AD

GLTESTZ

7 0CT 2008

System Status 14:35
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Problem: Directly moving from a 3rd party
application to GSNX may not work.

Details: Each SDK application has a unique internal "Product ID". Because the
GSNX standard SDK application and non-activation SDK application use different
"Product IDs", there may be a problem if the customer uses an application that
allows users to move to a different application based on the specified "Product ID".

Conditions of occurrence:
- List of 3rd party applications

- Pharos iMFP

- Equitrac

- Ringdale

- Barr Systems
- The GSNX standard SDK application has been replaced by the GSNX non-
activation SDK application on the device.
In this case, the application switching function will no longer be able to access
GSNX as a destination until the Product ID is re-configured.

Required Action:

Replacement of the previous non-activation (Product ID: 336921056) module with
the updated module:

1. Uninstall the previous non-activation version (Product ID: 336921056) from the
device. This procedure is described below.

2. Install the updated SDK application (Product ID: 336920832).

%";tg Affected Replacement | Replacemen
Versio Product ID B Server t Embedded Product ID
n y Module Module
336921056
Non- Product ID i 336920832
V1.5.2 . Hex: . Not Required V1.5.4.2 )
Activation 141501E0 issue Hex: 14150100
336921056
vi.53 | , Nom- Hex: ProductID | ot Required | V1.5.4.2 R
Activation 141501E0 issue Hex: 14150100

Note: The hexadecimal value of the Product ID is used by Remote Manager’s Export
Function.

How to confirm whether the installed module is affected:
It is recommended to distinguish the problematic module using Remote Manager.
The module can be distinguished with:
- Combination of application name and its version.
Or
- Product ID

- The affected non-activation application is named “GlobalScan NX(N)”.
If application name is “GlobalScan NX”, the application is standard module and
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not affected by the issue. Check using Remote Manager, WIM or device’s
operation panel.
- Problematic application versions are 1.5.2 or 1.5.3.
As problematic non-activation versions are released as v1.5.2 and v1.5.3, the
combination of application name and version can quickly identify an affected
device.
Version information is available from Remote Manager, WIM or device’s operation
panel.
- Problematic application’s Product ID is 336921056. This ID can be checked using
WIM or the device’s operation panel.

Remote Manager: Confirm the application name and version.
Can be confirmed either from the Ul and the exported csv. If the number of
devices is high, exporting the csv is recommended.

UlI:
1. Make sure the devices are registered with Remote Manager.
2. Confirm that the product name and version are an affected version by
opening the device properties for each device.
Device Properties |E|
Addiess: 10.B1.73.127
todel name: Aficio MP C3300
Java Wk version: 428

Application list:

Application name Version Status

Exported CSV:
1. Make sure the devices are registered with Remote Manager.
2. Export the device list CSV (Operations > Export).
3. Open the csv using the desired application (such as Excel).
4. The Product ID is output as a HEX value. “141501E0” indicates an affected
module (see previous table).
## Client Activator V2 created

#MFD MFD ProductlD Feature  ProductKey ProductName
Address Name

192.168.0.10 14150100 3.37E+08 GS-NX
192.168.0.10

192.168.0.20 141501E0 3.37E+08 GS-NX(N)
192.168.0.20

WIM: Confirm the application name, version and product ID.
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Open WIM > Extended Feature Settings > Extended Feature Info.
Extended Feature Info

| Back |

B E:tended Feature Name ;| G5-Mx

B Cescription  GlobalScan Mx
W ersion 11544

B Product ID » 336920832

B Startup Location : 50 Card Slot 1

Operation Panel: Confirm the application name, version and product ID.
Operation Panel > User Tools/Counter > Extended Feature Settings > Extended Feature
Info.

Extended Feature Info

The following extended feature has been installed.

P-Exctended Feature Name: G5—hX (M) PFroduct ID: 336920832
PDescription: GlobalScan My (W)
»Version: 1.5.4. P-Auto Start: on || off

P Installation Taroet: S0 Card Slot 2

Pendor:

P Contact: TEL:
Fax:
E-mail:

Job List

Uninstalling the previous non-activation version from the device:

1. Turn on the target machine.

2. Uninstall the GlobalScan NX SDK application, but not the Java VM application, using
the operation panel or Remote Manager.

Remote Manager:
1. Select a target device.

23 Untitled - Embedded Software Remote Manager
File Operation Yiew Help

Embedded Software Remote Manager

Device list - Application: |Heil@(ietMair{3355??455-UU] LI

3
+ 5| Product Key Address Description #of ... | Product Key Lock Cod
Software pocx X xxx. 2 14020-81000-0... 400-*17)

cav2i057

2. Open the "Operation” menu and click "Uninstall”.



i Untitled - Fmbedded Software Remote Manager

Operation R ]
Add

Export...
4 Install...

Get License...
Recover License...
Store License. ..
Deactivate...

E
¥ Delete Del
- E Properties. .. Enter address Description #of ... | Product Key Lock Cod

Uninstall. ..

Devicelist - Application: |HellaXletMain(335677456.00) |

cav2i039ra

Select the software to uninstall and click the “OK” button.

Uninstall

Software:

Select software to uninstall,

oftware name

| -~

[HelloXlethain 335677456

|

0K Cancel

cav2i040
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Ask a machine administrator to input a user name and password of the machine administrator and

then click “OK”.
Login
Enter authentication information for device management.
Address: XXX XXX XXX XX
User: * admin
Password: »
OK Cancel
cav2i013

Click the "OK" button once the uninstall process has completed.
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 of

Flakiech e vaicon, sl fostasting the tlevics o s e setube.
HENENRRNNNNNNENERN| oo

caval cav2i043

6. Select the target machine to view in the Device List.

7. Select the "View" menu item and click "Refresh.

Intitlad = Fmhaddad Cnfherara Dampte Mandger

File Operation RUETN Help

HE Embedded 50 Sn_r;er = = —
D list - Application: |(Select licat
Device Lis  Refresh all i et I[, bl il bt -:J

Address Description # of Product Key

¥
® %Pmduct Ke
Software XHH XXX XXK. XX AP-C1 2

cav2i058

Exit

Click "Refresh All" if you have uninstalled software from multiple devices. This refreshes all
devices in the "Device List".

New Chrl+N te Manager : it =
Device list - Application: |[Select an application A
Open... Ctrl+0 I ( i ) J
Save Ctr4s Address Description #of ... Product Key Lc

5677456-01) XK. XK. XK XX AP-C1 0

677456-00)

cav2i044a

2. Install the fixed SDK application.

The Procedure is the same as described in “GlobalScan NX SDK application
Installation”
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Appendix

A) Installed GlobalScan NX Edition Confirmation

Access Start>GlobalScan NX>Activation Tool

VEgysevees () serup N .
é Internet Explorer & clobalscan M Activation Toal
% Windaws Lpdat Lﬁl Qutlook Express % GlobalScan My AdminT ool
i PRemate Assistance @ GlobalScan M Manuals
:@ Symantec Endpoint Protection * %3 GlobalScan My S50 Setting Tool

@ adrinistrative Tools » £] Readme
ﬁi GlobalScan My 3 E] Readme {Barcode Plug-in}

Log OFf @ Shut Diawn

Idi%SI:art J @ g J |33 Windows Explarer vl %Services | 1@' bar-ove

All Brograms

If your customer is using a Server Edition, you will find the installed server edition in the
Activation List. If Serverless edition is installed, no entry appears in the Activation List.
(The sample below shows that Enterprise Server Edition has been installed).

GlobalScan Nx x|

Ackivation List

Glabalscan MY Barcode Plug-in Far Enterprise Server
Globalacan My Enkerprise Server

B) Secondary Delivery Server/Load Balance Server Confirmation

1) Check the System menu for the following two selections.
* If the settings are not available, these options are not used by that customer’s
environment.
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Home Configuration Maintenance Setting

System Profile Device

System Settings
o

General Settings
) Services fFilters

b~
o~
l w Authentication Profiles

Administrator
Job Settings
System Logs
Certificate

Replacement Table

| Secondary Delivery Server Settings |

| Load Balance Server Settings |

Kerberos Option

2) If the above settings are available, please check to see if your customer is actually
using them:

Secondary Delivery Server

Home Configuration Maintenance Settings

Profile Device

Secondary Delivery Server Settings

¥ lize Secandary Delivery Server

Secondary Delivery Server

¥ http:/fsecondary ricohl B080/gsnx | Browse |

If a Secondary server is used, this setting needs to be removed before upgrading the
GlobalScan NX software. For the details, please refer to Appendix C.

Load Balance Server

m Configuration Maintenance Settings
Profile Device

Load Balance Server Settings

Add Load Balance Server

| Add
Load Balance Mermber Server List | Previous Synchronization Date

| http:i192.168.0.10:8080/gsmx | 11/28/2010 10:17:59
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If a Load Balance server is used, this setting needs to be removed before upgrading the
GlobalScan NX software. For the details, please refer to Appendix C.

C) How to disable Secondary Server/Load Balance Server settings

@ Note )
This section also describes the basic process for upgrading the software installed
on any Secondary Delivery or Load Balance servers.

Secondary Delivery Server.

Uncheck the [Use Secondary Delivery Server] check box.

Hoime Configuration Malntenance Job Manages

Sy=bem Prufile Dewice

| Secondary Delivery Server Settings

.1{ Ilze Secondary Delivery Servar

Secondary Delivery Servar

[Procedure for upgrading GlobalScan NX Software]

1. Perform overwrite data installation on the Secondary server.

2 Perform overwrite data installation on the Primary server.

3. Add the Secondary server to the Primary server.

4. Synchronize the Primary Delivery Server with the Secondary Server.

Load Balance Server

Remove the Load Balance Server(s) from the Load Balance Member Server list on the
Primary server.

m Configuration Maintenance Settings Job &

System Profile Device

Load Balance Server Settings

Add Load Balance Server

Add Delate

Load Balance Member Server List | Previous Synchronization Date

https:/ff" ™ "~ 8443fgsn: 07/28/2008 14:46:06
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[Procedure for upgrading GlobalScan NX Software]

1. Perform overwrite data installation on the Load Balance server(s).

2. Perform overwrite data installation on the Primary server.

3. Add the Load Balance Server(s) to the Primary server.

4. Synchronize the Primary Delivery Server with the Load Balance Servers.

D) How to determine if Option Plug-ins are installed

Please run the GlobalScan NX Activation Tool.

\% Setvices ;@ Starkup > I -

é Internet Explorer & clobalscan M Activation Toal
% Windaws Lpdat Lﬁl Qutlook Express % GlobalScan My AdminT ool
. PRemote Assistance @ GlobalScan M Manuals

:@ Symantec Endpoint Protection * %3 GlobalScan My S50 Setting Tool
@ adrinistrative Tools » £] Readme
ﬁi GlobalScan M (2 E] Readme (Barcode Plug-in)

Log OFf @ Shut Diown

Itf_ﬂStart J @ ﬂ J |03 Windows Explorer -l %Services | 1@' bar-ovel

All Programs

The Activation List shows the installed & activated option plug-ins.
This sample image shows that the Barcode Plug-in has been installed.

GlobalScan NX ] x|

Ackivation List

Globalscan My Barcode Plug-in For Enterprise Server
Global3can My Enterprise Server

Qi |
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Reissued:19-Jul-12
Model: GlobalScan NX Date: 9-Apr-12 No.: RD420014c I

RTB Reissue
The items in bold italics have been corrected.

Subject: GlobalScan NX Installation to 717A/12S Models Prepared by: M.Horikoshi
(AT-C3, AP-C3, AL-C2, MT-C5, GR-C1 and S-C5)

From: Solution Support Department

Classification: |IX Troubleshooting [] Part information ] Action required
] Mechanical [] Electrical [] Service manual revision
[] Paper path [] Transmit/receive [] Retrofit information
[] Product Safety [] Other ( ) X Tier 2

Summary

When installing GlobalScan NX (GSNX) to some 11A/72S models, certain actions must be
performed in order to ensure correct operation.

1. Only the GlobalScan NX versions listed below may be installed on the current 11A/72S models
For AT-C3, AP-C3, AL-C2:

- GSNX PC application v1.5.2.0 or later and GSNX SDK application v1.5.4.2 or later

For GR-C1, S-C5:

- GSNX PC application v1.5.5 or later and GSNX SDK application v1.5.5 or later

- GSNX PC application v2.0.1 or later and GSNX SDK application v2.0.1 or later

For MT-C5:

- GSNX PC application v1.5.4.0 or later and GSNX SDK application v2.1.0 or later

2. Because the standard Java VM and System/Copier Firmware contains some bugs known to
affect GSNX, these must be upgraded before GlobalScan NX SDK application installation.

1. 11A Model Support and PC application Version Compatibility:
Following chart shows the compatibility between modules/versions.

Embedded Module (SDK application)
V2.01
V15.4.0 V1542 V155 V2.0.0 Vo1
V1520
Vieso NO YES YES NO NO
Server V1.5.4.0 YES YES YES YES YES
Modu|e V1 542
(PC V155 YES YES YES YES YES
application)
V2.0 YES YES YES YES YES
V2.01
- YES YES YES YES YES

Note1: V1.5.4 of the PC application is released as a full installer (supports both new and upgrade installations).
Note2: V1.5.4.2 of the PC application is released only as an update program (upgrade installation only).
Note3: V1.5.4 and V1.5.4.2 of the PC application have no functional differences.
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2. Required Java VM Version:

Model Version Program No. Effective Date
AT-C3 10.04.02 D1445594E April 2012 production
AP-C3 10.04.02 D1445594E April 2012 production
AL-C2 10.04.02 D1295735D April 2012 production
MT-C5 10.05.01 D13155908B First Mass Production
GR-C1 10.04.02 D6405750H April 2012 production
S-C5 10.04.02 D6405750H April 2012 production

Note: The same UpdateTool module can be used even though the Program No. is different.
Note: The table above lists the version which implements the fix. It is always recommended
to use the latest Java VM.

GSNX SDK application v1.5.x:

- Update Device’s JavaVM using Remote Install Manager or Java VM Update Tool.

- Note: GSNX v1.x cannot be installed with Remote Install Manager. It is only for updating the
device’s Java VM.

GSNX SDK application v2.0 or later:
Update Device’s JavaVM using Remote Install Manager. Update is automatically performed when
the GSNX SDK application is installed. No specific action is required.

3. 11A models don't reply to network requests for SDK applications.

Occurrence Condition:

If a SDK application has a Web Ul, it cannot be accessed from a web browser once the device
enters STR mode. Also, remote configuration from the administration tool is impossible. This is
known to affect:

- GSNX synchronization from the AdminTool.

Workaround (either):

- Disable STR mode.

- Retry the operation (as the first network request to the SDK application wakes the device up
from STR mode, the second attempt will succeed).

Fixed System/Copy Firmware Version:

Model Version Program No. Effective Date
AT-C3 2.03 D1425562L June 2012 production
AP-C3 2.03 D1445562L June 2012 production
AL-C2 2.03 D1295751J June 2012 production
GR-C1 1.07 D1175421H June 2012 production
S-C5 1.07 D1275780G June 2012 production
MT-C5 1.01 D1315572C July 2012 production

Note: The table above lists the version which implements the fix. It is always recommended
to use the latest System/Copy Firmware.
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Model: XG-SD1

Date: 08-Nov-11

RTB Reissue

The items in bold italics have been corrected.

Subject: Release Note: GlobalScan NX

From: Solution Support Sect., Solution Support Dept.

Prepared by: M.Horikoshi

Classification:

[] Troubleshooting
[] Mechanical

[] Paper path

] Product Safety

] Part information

] Electrical
] Transmit/receive
X Other ( )

] Action required
[] Service manual revision
[] Retrofit information
X Tier 2

This RTB has been issued to announce the module release information for the
GlobalScan NX.

Version Program No. Effective Date Availability of RFU
1.5.6.0 D4205101Q October 2012 production Not available
1.5.5.0 D4205101P May 2012 production Not available
1.5.4.2 D42051010 March 2012 production Not available
1.5.4.0 D4205101N January 2012 production Not available
1.5.3.0 D4205101M September 2011 production Not available
1.5.2.0 D4205101L June 2011 production Not available
1.5.1.0 D4205101K May 2011 production Not available
1.4.4.0 D4205101J November 2010 production Not available
1.4.1.0 D4205101| July 2010 production Not available
1.3.5.0 D4205101H January 2010 production Not available
1.3.3.0 D4205101F December 2009 production Not available
1.2.1.0 D4205101E May 2009 production Not available
1.2.0.0 D4205101D April 2009 production Not available
1.1.3.0 D4205101C January 2009 production Not available
1.1.2.0 D4205101B December 2008 production Not available
1.1.1.0 D4205101A 1st Mass production Not available

Note: Definition of Availability of RFU via @Remote
“Available”: The firmware can be updated via RFU or SD card.
“Not available”: The firmware can only be updated via SD card.

No.: RD420003p
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Reissued: 02-Nov-12

Model: XG-SD1 Date: 08-Nov-11 No.: RD420003p

Version

Modified Points or Symptom Corrected

1.5.6.0

Others:

- The "Cancel” button is now grayed out when performing an update,
overwrite, or leftover data installation.

- GSNX now attempts a retry when fax data reception fails.

Fixed:

- Users may be unable to log in to a Project after a Profile is synchronized to
multiple devices at the same time.

- Creating a subfolder on a Domain-based DFS system causes Send to
Folder delivery to fail.

- GSNX fails to deliver to a Domain-based DFS destination in a network
where the server acting as the Domain controller and the server controlling
the DFS system are different.

- Fax delivery sometimes fails for certain device models.

Update the Java VM to the latest version before installing this update.

1.5.5.0

Supported:

GlobalScan NX now supports the following devices:
Aficio MP 301

Aficio MPC 305/DSc530

Aficio MP 6002/7502/9002

Fixed:
The OCR Filter, PDF Converter, Image Convertor consume more of GlobalScan NX's
memory than is necessary (Server Edition).

1.5.4.2

Supported:

GlobalScan NX Serverless/Business Server/Enterprise Server Edition V1.5.4.2 now
supports the following devices:

Aficio MP C4502 / Aficio MP C5502 / Aficio MP C3002 / Aficio MP C3502 / Aficio MP
4002 / Aficio MP 5002

1.5.4.0

Others:

- A Windows Server 2008 R2 AD server is now supported for Active Directory
Authentication. (Serverless Edition Only).

- Send To Email plugin allows to use "Default Sender Address" as sender email
address regardless of the login user's email address.

- Send To Email plugin's email address validation now can be disabled.

Fixed:

- Scan Size setting may not be applied correctly if it is configured in System >
Servie/Filter Settings > Scan Settings.

- Unable to input capital letters as destination email address in Send To Email
plugin.

- OutOfMemory or InsufficientMemory error occurs when the large size document
is sent via Send To Folder plugin.

- Flow Redirector/Table Replacement filters can be overwritten in multi-thread,
multi-job environment.

- Some wordings are corrected.
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Reissued: 02-Nov-12
Model: XG-SD1 Date: 08-Nov-11 No.: RD420003p

Version Modified Points or Symptom Corrected

1.5.3.0 [1) Device Support Changes

- GlobalScan NX Serverless/Business Server/Enterprise Server Edition V1.5.3.0
now supports the following devices:
Aficio SP 5200S/Aficio SP 5210SF/Aficio SP 5210SR/Aficio MP 2352SP/Aficio
MP 2852SP/Aficio MP 3352SP

2) Specification Changes

- A "Batch Download Logs" button has been added to the AdminTool's
Maintenance Settings. It is used to download different log types from the
AdminTool and the selected devices in a batch operation.

- NTLM authentication requests now use standard formatting. Previous versions
used a different formatting that could be authenticated even if the time skew
between GSNX and the authenticating server was great.

3) Fixed Issues

- Fixed: The Send to Email function does not send Notifications.

- Fixed: Wide format paper sizes would not be displayed on the Scan Size tab
after updating to V1.5.2.0.

- Fixed: Garbage/useless data would be included in imported Profiles. If a single
Profile went though multiple export-import cycles, it could eventually cause
SC997 on synchronization.

- Fixed: Send to Folder can fail due to an out of memory error if a non-domain
controller responds to a request when using a NetBIOS user name and the
amount of scan data is large.

1.5.2.0 | 1) Fixed Issues
- Fixed: Activation information is lost if a Remote Desktop Console session is
used to perform an upgrade from GSNX V1.4.4 to GSNX V1.5.

2) Other
- When the "Cancel" button is used to cancel a job in the job queue, the cancelled
job is now moved to the error queue.
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Reissued: 02-Nov-12
Model: XG-SD1 Date: 08-Nov-11 No.: RD420003p

Version Modified Points or Symptom Corrected
1.5.1.0 [1) Device Support Changes
- GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.5.1.0
now supports the following device:
Aficio MP 201F/201SPF.

2) Specification Changes

- Users can now scan directly from the Metadata input screen.

- A new Scan Method, “Mixed Batch,” was added.

- Support for PDF/A when using the Send To E-mail's Page Divide function.

- LDAP Search results are now sorted.

- Support for the UPN (username@FQDN) is now available when using Active
Directory as the authentication method.

- Please note that if the UPN's FQDN and the domain stored in the AD
authentication profile do not match, the UPN's domain must be registered as a
trusted domain.

- NTLM v2 authentication is now supported for authenticating with a WebDAV
server.

3) Fixed Issues

- Fixed: Projects requiring authentication cannot be logged in to on 4-line MFPs, if
the project was searched for by number.

- Fixed: E-mail addresses that GSNX failed to deliver to (due to an invalid IP
address for the SMTP server, etc.) are included in the Job Log's "Destination
Address" column.

- Fixed: A SFTP connection session remains even after the FTP delivery service
completes delivery.

- Fixed: After upgrading GSNX Enterprise Server, only 32 devices remain in the
Device list.

- Fixed: Extra authentication information is included in imported profiles.

- If the extra information builds up, it could eventually reduce performance when
changing screens on the operation panel or SC997.

4) Other

- When more devices are registered in the device list than the current edition
allows, the extra devices must be deleted before synchronization or other device
management actions can be performed.

- This only occurs when an overwrite installation, leftover data installation, or
backup data restoration occurs between different editions of GSNX.

- GSNX no longer writes data to the SD-Card as a part of log creation.
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Model: XG-SD1 Date: 08-Nov-11 No.: RD420003p
Version Modified Points or Symptom Corrected
1.4.4.0 | 1) Device Support Changes

GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.4.4.0 now

supports the following devices:
Aficio MP C300/C400/C4501/C5501/C3001/C3501/C2051/C2551/

W2401/W3601
The Aficio MP C300/C400 does have a limitation:
GSNX v1.4.4.0 can only scan A4/Letter landscape documents on the Aficio MP

C300/C400.

2) Specification Changes
It is now possible to select the location where the output of the Metadata

Replacement filter is saved.
SDK application version information and other data are now written to the GSNX

system log when the MFP starts up.

3) Fixed Issues
Fixed: Exported Replacement Tables that contain a comma in the Comparison

Target String are not imported correctly.
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Model: XG-SD1

Date: 08-Nov-11 No.: RD420003p

Version

Modified Points or Symptom Corrected

1.4.1.0 | 1) Device Support Changes

2) Specification Changes

3) Fixed Issues

GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.4.1.0
now supports the following devices:
Be-C1
-——N-G3

A hardware key can now be used to access the project search function on the
Model Aficio MP 171SPF/LD117SPF/917SPF.

The GlobalScan NX icon is now displayed on the Extended Features screen.
The Activation Tool can now be used to activate the Kerberos option.

The Kerberos option is now supported for use with GSNX Serverless.
"Passwordless Authentication" (Active Directory and LDAP) has been added as
an authentication method.

A confirmation dialogue now appears when a scan job completes.

Wide format paper sizes have been added to scan settings menu.

"Continue flow without performing replacement" has been added to the "Select
Action when Table Data does not Match" menu.

A log entry is recorded in the Syslog when the metadata replacement filter does
not match.

The tag "JIS" has been added to the "Bx" paper size.(e.g.; B4 JIS)

The dayofweek and generationDate(Local) metadata fields have been added.
The Error Queue now supports batch downloading of error images.

The IP address field of the device list now links to each registered device's Web
Image Monitor.

A Plug-in Information page has been added to the AdminTool.

"Logical Division (Join Automatically)" has been added as an e-mail attachment
Size Divide option.

Support for PDF/A has been added to the PDF Converter.

The user's home folder and email address can now be retrieved from an
authentication server that is not used for the authentication profile.

The total number of entries for the replacement table has been raised from 1000
to 2000.

New fax templates for fax delivery based on day of the week or time are
available for installation with the other project templates.

Fixed: When logging in to the project without a password, delivery fails if scan to
home folder is used.

Fixed: The Operation panel locks as a result of logging out via the logout key
while a dialog box is displayed.

Fixed: LDAP server address search fails if the DN of the login user is required
when attempting email delivery.

Fixed: The Start key turns red and cannot be pressed if the project only contains
Flow Redirect and was restored from a profile created by GSNX v1.3.4.0 or
earlier.

Fixed: The Start key would turn green when the error dialog that appears when
the same password is input as both the user and master passwords for the PDF
conversion filter is closed.
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Version Modified Points or Symptom Corrected

1.3.5.0 | 1) Device Support Changes

- GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.3.5
now supports the following devices:

V-C3

2) Specification Changes

- Support for Windows 7 Ultimate/Enterprise/Professional Edition has been
added.
However, Windows 7 is only supported by GlobalScan NX Serverless Edition
V1.3.5.0.

3) Fixed Issues

- Fixed: A communication error occurs while using GlobalScan NX's AdminTool.
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Version

Modified Points or Symptom Corrected

1.3.3.0 | 1) Device Support Changes

2) Specification Changes

3) Fixed Issues

GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.3.3
now supports the following devices:

MT-C4

S-C4

Support for 64-bit versions of Windows 2003/2008 Standard/Enterprise Edition
(including "without Hyper-V") has been added.
However, GSNX must be run in 64-bit compatible mode (WoW 64). This means
GSNX runs as a 32-bit program even when using a Windows 64-bit OS.
Projects using an authentication profile are now supported for use on the S-C4.
If GlobalScan NX V1.3.3 is installed on a server where a data path for an older
GSNX exists, activation information will be inherited regardless of any
differences between the old and new data paths.
If “Delete data path” is selected when uninstalling GSNX V1.3.3, that activation
information will be lost.
The SDK application's version number can now be displayed on the AdminTool's
Device List.
A message warning users about active sessions will appear when attempting to
do any of the following actions:

Trying to close the web browser.

Clicking the "Reload" button on the web browser.

Accessing another web page directly from any screen of the GSNX

AdminTool.
If an attempt is made login to the GSNX AdminTool while an administrator is
already logged in, the IP address or hostname of the logged in administrator's
PC will be included in the error dialog.
Performance when importing/exporting a profile has been improved.
If a Filter has settings available on the Filter tab of the GSNX AdminTool, that
Filter Plug-in’s Filter tab settings can be displayed on the MFP operation panel.
LDAP Authentication now supports two directory access methods:
LDAP search (Proxy User and Search Query settings)
Affixation (LDAP Prefix/Suffix settings)
LDAP searches using a Login User's account are now available when searching
for a destination email address from the Send to Email Plug-in.
GSNX now supports Gmail's SMTP server.
"Send to Home Folder", when enabled, now has access to all of the same
general settings as the Send to Folder Plug-in.
GSNX now displays “Home Folder” in the Selected Destinations list if “Send to
Home Folder” is enabled.
Also, GSNX now allows access to any subfolders located in the Home Folder as
long as “Enable Subfolder Browsing” for Send to Home Folder is enabled.
GSNX V1.3.3 now supports multidomain authentication. GSNX assumes that the
host exists on the same domain as the authentication server if only a hostname
is used to access a user’'s Home Folder (homedirectory) when using “Send to
Home Folder”.
LDAP authentication is now supported for use with the Send to Home Folder
function of the Send to Folder Plug-in.
Passwords added when using the PDF Converter Plug-in of GSNX Serverless
Edition now function correctly.
Password policy (character length, regular expressions) and password
confirmation settings have been added to the PDF Converter Plug-in.

Fixed: Performing an overwrite install for update purposes fails if the previous
version of GSNX has never been launched.

Fixed: Cancelled jobs may remain in the AdminTool's Job Queue.

Fixed: GSNX sends all the scanned data again when GSNX fails to completely
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1.2.1.0 | Added support for new device:
1) MT-C4, a 08A device, is now supported for use with GlobalScan NX.

Fixed Issues:

1). Previous versions of GlobalScan NX had slow screen changes, especially when
accessing the project list screen, the scan settings screen, and the service menu
screen. These screens have been speed up.

2). Files smaller than 43 bytes can now be uploaded when using an SSL connection
with the built-in web server.

3). Anissue where data might be sent between the AdminTool and the PC where
GlobalScan NX is installed (Server or Serverless versions) without being
encrypted has been fixed.

4). Anissue that prevented some information from being converted from version
1.1.x to version 1.2 during an update install has been fixed.

1.2.0.0 | Other Changes:

(1) Support for Scan Preview has been added for 07A and later models.

(2) Several new metadata items have been added. Please refer to the "Metadata
Specifications" of the Administrator's Guide for more details.

(3) Support for Latin-1 character encoding has been added.

(4) General Performance Improvements

1.1.3.0 | Fixed: SC997 occurs during the operation of MFP applications (Copy, Print, etc).
(Reported by Tech Mail No.: TS081556)

1.1.2.0 | Other Changes:

1. The RightFAX plugin is supported.

2. The Output plugin's StartPointPath can be edited.
3. Flash Player 10 is supported.

1.1.1.0 | 1st Mass production
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RTB Reissue

The items in bold italics have been added.

Subject: Release Note: GlobalScan NX (Update Module) Prepared by: M. Horikoshi

From: Solution Support Sect., Solution Support Dept.

Classification: |[] Troubleshooting [] Part information ] Action required
[] Mechanical [] Electrical [] Service manual revision
[] Paper path [] Transmit/receive [] Retrofit information
[] Product Safety X Other ( ) X Tier 2

This RTB has been issued to announce the module release information for the
GlobalScan NX.

This module is used for updating the GlobalScan NX SDK application from ver. 1.3.x or
earlier to ver. 1.3.x using Remote Manager.

Version Program No. Effective Date Availability of RFU
1.5.6.0 D42051711 October 2012 production -
1.5.5.0 D4205171H May 2012 production -
1.5.4.2 D4205171G March 2012 production -
1.5.3.0 D4205171F October 2011 production -
1.5.2.0 D4205171E June 2011 production -
1.4.4.0 D4205171D December 2010 production -
1.4.2.0 D4205171C August 2010 production -
1.3.5.0 D4205171B January 2010 production -
1.3.4.1 D4205171A December 2009 production -
1.2.2.0 D4205171 May 2009 production -

Note: Definition of Availability of RFU via @Remote
“Available”: The firmware can be updated via RFU or SD card.
“Not available”: The firmware can only be updated via SD card.

Version Modified Points or Symptom Corrected

1.5.6.0 | Others:

- The "Cancel” button is now grayed out when performing an update,
overwrite, or leftover data installation.

- GSNX now attempts a retry when fax data reception fails.

Fixed:

- Users may be unable to log in to a Project after a Profile is synchronized to
multiple devices at the same time.

- Creating a subfolder on a Domain-based DFS system causes Send to
Folder delivery to fail.

- GSNX fails to deliver to a Domain-based DFS destination in a network
where the server acting as the Domain controller and the server controlling
the DFS system are different.

- Fax delivery sometimes fails for certain device models.

Update the Java VM to the latest version before installing this update.
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1.5.5.0 | Supported:

GlobalScan NX now supports the following devices:

Aficio MP 301

Aficio MPC 305/DSc530

Aficio MP 6002/7502/9002

Fixed:

The OCR Filter, PDF Converter, Image Convertor consume more of GlobalScan
NX's memory than is necessary (Server Edition).

1.5.4.2 | Supported:

GlobalScan NX Serverless/Business Server/Enterprise Server Edition V1.5.4.2 now
supports the following devices:

Aficio MP C4502 / Aficio MP C5502 / Aficio MP C3002 / Aficio MP C3502 / Aficio MP
4002 / Aficio MP 5002

Others:

- A Windows Server 2008 R2 AD server is now supported for Active Directory
Authentication. (Serverless Edition Only).

- Send To Email plugin allows to use "Default Sender Address" as sender email
address regardless of the login user's email address.

- Send To Email plugin's email address validation now can be disabled.

- Image Correction Filter's minimum supported resolution is expanded to 80dpi as
inbound FAX sometimes has less than 100dpi resolution.

- "RICOH" logo is added to installer and AdminTool.

Fixed:

- Scan Size setting may not be applied correctly if it is configured in System >
Servie/Filter Settings > Scan Settings.

- Unable to input capital letters as destination email address in Send To Email
plugin.

- OutOfMemory or InsufficientMemory error occurs when the large size document
is sent via Send To Folder plugin.

- Flow Redirector/Table Replacement filters can be overwritten in multi-thread,
multi-job environment.

- Unable to process specific PNG format and image library stopped (Server
Edition Only).

- Saving TIFF image increase the image resolution unexpectedly (Server Edition
Only).

- OCR processing may result in buffer overun (Server Edition Only).

- Some wordings are corrected.

1.5.3.0 | 1) Device Support Changes

- GlobalScan NX Serverless/Business Server/Enterprise Server Edition V1.5.3.0
now supports the following devices:
Aficio SP 5200S/Aficio SP 5210SF/Aficio SP 5210SR/
Aficio MP 2352SP/Aficio MP 2852SP/Aficio MP 3352SP

2) Specification Changes
- A "Batch Download Logs" button has been added to the AdminTool's
Maintenance Settings. It is used to download different log types from the
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Version Modified Points or Symptom Corrected

AdminTool and the selected devices in a batch operation.

- NTLM authentication requests now use standard formatting. Previous versions
used a different formatting that could be authenticated even if the time skew
between GSNX and the authenticating server was great.

3) Fixed Issues

- Fixed: The Send to Email function does not send Notifications.

- Fixed: Wide format paper sizes would not be displayed on the Scan Size tab
after updating to V1.5.2.0.

- Fixed: Garbage/useless data would be included in imported Profiles. If a single
Profile went though multiple export-import cycles, it could eventually cause
SC997 on synchronization.

Fixed: Send to Folder can fail due to an out of memory error if a non-domain
controller responds to a request when using a NetBIOS user name and the amount
of scan data is large.

1.5.2.0 | 1) Device Support Changes
- GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.5.2.0
now supports the following device:
Aficio MP 201F/201SPF.

2) Specification Changes

- Users can now scan directly from the Metadata input screen.

- A new Scan Method, “Mixed Batch,” was added.

- Support for PDF/A when using the Send To E-mail's Page Divide function.

- LDAP Search results are now sorted.

- Support for the UPN (username@FQDN) is now available when using Active
Directory as the authentication method.

Please note that if the UPN's FQDN and the domain stored in the AD
authentication profile do not match, the UPN's domain must be registered as a
trusted domain.

- NTLM v2 authentication is now supported for authenticating with a WebDAV
server.

3) Fixed Issues

- Fixed: Projects requiring authentication cannot be logged in to on 4-line MFPs, if
the project was searched for by number.

- Fixed: Users could attempt to login to the SDK application during
synchronization. This would always fail, and is no longer possible.

- Fixed: E-mail addresses that GSNX failed to deliver to (due to an invalid IP
address for the SMTP server, etc.) are included in the Job Log's "Destination
Address" column.

- Fixed: A SFTP connection session remains even after the FTP delivery service
completes delivery.

- Fixed: After upgrading GSNX Enterprise Server, only 32 devices remain in the
Device list.

- Fixed: Extra authentication information is included in imported profiles.

- If the extra information builds up, it could eventually reduce performance when
changing screens on the operation panel or SC997.
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- Fixed: Activation information is lost if a Remote Desktop Console session is used
to perform an upgrade from GSNX V1.4.4 to GSNX V1.5.

4) Other

- When more devices are registered in the device list than the current edition
allows, the extra devices must be deleted before synchronization or other device
management actions can be performed.

- This only occurs when an overwrite installation, leftover data installation, or
backup data restoration occurs between different editions of GSNX.

- GSNX no longer writes data to the SD-Card as a part of log creation.

- When the "Cancel" button is used to cancel a job in the job queue, the cancelled
job is now moved to the error queue.

1.4.40 (1) Device Support Changes
GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.4.4.0 now
supports the following devices:
- Aficio MP C300/C400/C4501/C5501/C3001/C3501/C2051/C2551/
W2401/W3601
The Aficio MP C300/C400 does have a limitation:
- GSNXv1.4.4.0 can only scan A4/Letter landscape documents on the Aficio
MP C300/C400.

2) Specification Changes

- ltis now possible to select the location where the output of the Metadata
Replacement filter is saved.

- SDK application version information and other data are now written to the GSNX
system log when the MFP starts up.

3) Fixed Issues

Fixed: Exported Replacement Tables that contain a comma in the Comparison

Target String are not imported correctly.

1.4.2.0 | Minor bug correction.

1.3.5.0 [ 1) Device Support Changes

- GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.3.5
now supports the following devices:

V-C3

2) Specification Changes

- Support for Windows 7 Ultimate/Enterprise/Professional Edition has been
added.

- However, Windows 7 is only supported by GlobalScan NX Serverless Edition
V1.3.5.0.

3) Fixed Issues

- Fixed: A communication error occurs while using GlobalScan NX's AdminTool.

1.3.4.1 | 1) Device Support Changes
- GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.3.3
now supports the following devices:
MT-C4
S-C4
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2) Specification Changes

- Support for 64-bit versions of Windows 2003/2008 Standard/Enterprise Edition
(including "without Hyper-V") has been added.

- However, GSNX must be run in 64-bit compatible mode (WoW 64). This means
GSNX runs as a 32-bit program even when using a Windows 64-bit OS.

- Projects using an authentication profile are now supported for use on the S-C4.

- If GlobalScan NX V1.3.3 is installed on a server where a data path for an older
GSNX exists, activation information will be inherited regardless of any
differences between the old and new data paths.

- If “Delete data path” is selected when uninstalling GSNX V1.3.3, that activation
information will be lost.

- The SDK application's version number can now be displayed on the AdminTool's
Device List.

- A message warning users about active sessions will appear when attempting to
do any of the following actions:

Trying to close the web browser.

Clicking the "Reload" button on the web browser.

Accessing another web page directly from any screen of the GSNX
AdminTool.

- If an attempt is made login to the GSNX AdminTool while an administrator is
already logged in, the IP address or hostname of the logged in administrator's
PC will be included in the error dialog.

- Performance when importing/exporting a profile has been improved.

- If a Filter has settings available on the Filter tab of the GSNX AdminTool, that
Filter Plug-in’s Filter tab settings can be displayed on the MFP operation panel.

- LDAP Authentication now supports two directory access methods:

LDAP search (Proxy User and Search Query settings)
Affixation (LDAP Prefix/Suffix settings)

- LDAP searches using a Login User's account are now available when searching
for a destination email address from the Send to Email Plug-in.

- GSNX now supports Gmail's SMTP server.

- "Send to Home Folder", when enabled, now has access to all of the same
general settings as the Send to Folder Plug-in.

- GSNX now displays “Home Folder” in the Selected Destinations list if “Send to
Home Folder” is enabled.

- Also, GSNX now allows access to any subfolders located in the Home Folder as
long as “Enable Subfolder Browsing” for Send to Home Folder is enabled.

- GSNX V1.3.3 now supports multidomain authentication. GSNX assumes that the
host exists on the same domain as the authentication server if only a hostname
is used to access a user's Home Folder (homedirectory) when using “Send to
Home Folder”.

- LDAP authentication is now supported for use with the Send to Home Folder
function of the Send to Folder Plug-in.

- Passwords added when using the PDF Converter Plug-in of GSNX Serverless
Edition now function correctly.

- Password policy (character length, regular expressions) and password
confirmation settings have been added to the PDF Converter Plug-in.

- The name and description shown on the MFP's Extended Feature Settings
screen has been changed to the following:
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Name: "GS-NX"
(This name is also displayed when the MFP function button assigned to
GSNX is pressed.)

Description: "GlobalScan NX"

- Support for Equitrac PCC V4.01 has been added.

3) Fixed Issues

- Fixed: Performing an overwrite install for update purposes fails if the previous
version of GSNX has never been launched.

- Fixed: Cancelled jobs may remain in the AdminTool's Job Queue.

- Fixed: GSNX sends all the scanned data again when GSNX fails to completely
send scanned data to the destination.

The fixed specification will only resend the data that failed to be sent. Data that
was sent correctly will no longer be resent.

- Fixed: GSNX fails to import a profile that only contains hidden groups.

- Fixed: When restoring backup data created by GSNX Serverless Edition on
GSNX Server Edition, PDF user/master passwords stored in the PDF Converter
Plug-in will not be restored.

- Fixed: If a project that has the Send to Folder Plug-in's "Selected Destinations”
set as a "Hidden Items" is imported from GSNX V1.2.x or earlier (via backup
data import/restore, overwrite install, or leftover data install), GSNX does not
check the write access rights for that project's destinations.

- Fixed: Home folders cannot be selected as a destination for projects that add a
new Send to Folder Plug-in when "Enable Send to Home Folder” is activated by
default in the System Settings or Profile Properties.

1.2.2.0

Added support for new device:

1) MT-C4, a 08A device, is now supported for use with GlobalScan NX.

Fixed Issues:

1). Previous versions of GlobalScan NX had slow screen changes, especially when
accessing the project list screen, the scan settings screen, and the service menu
screen. These screens have been speed up.

2). Files smaller than 43 bytes can now be uploaded when using an SSL connection
with the built-in web server.

3). Anissue that may have caused SDK application update installs to fail has been
fixed.

4). An issue where data might be sent between the AdminTool and the PC where
GlobalScan NX is installed (Server or Serverless versions) without being
encrypted has been fixed.

5). Anissue that prevented some information from being converted from version
1.1.x to version 1.2 during an update install has been fixed.
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RTB Reissue

The items in bold italics have been corrected.

Subject: Release Note: GlobalScan NX

From: Solution Support Sect., Solution Support Dept.

Prepared by: M. Horikoshi

Classification:

[] Troubleshooting
[] Mechanical

[] Paper path

] Product Safety

] Part information

] Electrical
] Transmit/receive
X Other ( )

] Action required

[] Service manual revision
[] Retrofit information

X Tier 2

This RTB has been issued to announce the module release information for the
GlobalScan NX for RAC.

Version Program No. Effective Date Availability of RFU
1.5.6.0 D4205201H October 2012 production Not available
1.5.5.0 D4205201G May 2012 production Not available
1.5.4.2 D4205201F March 2012 production Not available
1.5.4.0 D4205201E January 2012 production Not available
1.5.3.0 D4205201D September 2011 production Not available
1.5.2.0 D4205201C June 2011 production Not available
1.5.1.0 D4205201B May 2011 production Not available
1.4.4.0 D4205201A November 2010 production Not available
1.4.1.0 D4205201 1st Mass production Not available

Note: Definition of Availability of RFU via @Remote
“Available”: The firmware can be updated via RFU or SD card.
“Not available”: The firmware can only be updated via SD card.

Version

Modified Points or Symptom Corrected

1.5.6.0

Others:

The "Cancel” button is now grayed out when performing an update,
overwrite, or leftover data installation.
GSNX now attempts a retry when fax data reception fails.

Fixed:

Users may be unable to log in to a Project after a Profile is synchronized to
multiple devices at the same time.
Creating a subfolder on a Domain-based DFS system causes Send to
Folder delivery to fail.
GSNX fails to deliver to a Domain-based DFS destination in a network

where the server acting as the Domain controller and the server controlling
the DFS system are different.
Fax delivery sometimes fails for certain device models.

Update the Java VM to the latest version before installing this update.
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1.5.5.0 | Supported:
GlobalScan NX now supports the following devices:
Aficio MP 301

Aficio MPC 305/DSc530
Aficio MP 6002/7502/9002

Fixed:
The OCR Filter, PDF Converter, Image Convertor consume more of GlobalScan NX's
memory than is necessary (Server Edition).

1.5.4.2

Supported:

GlobalScan NX Serverless/Business Server/Enterprise Server Edition V1.5.4.2 now
supports the following devices:

Aficio MP C4502 / Aficio MP C5502 / Aficio MP C3002 / Aficio MP C3502 / Aficio MP
4002 / Aficio MP 5002

1.5.4.0

Others:

- A Windows Server 2008 R2 AD server is now supported for Active Directory
Authentication. (Serverless Edition Only).

- Send To Email plugin allows to use "Default Sender Address" as sender email
address regardless of the login user's email address.

- Send To Email plugin's email address validation now can be disabled.

Fixed:

- Scan Size setting may not be applied correctly if it is configured in System >
Servie/Filter Settings > Scan Settings.

- Unable to input capital letters as destination email address in Send To Email
plugin.

- OutOfMemory or InsufficientMemory error occurs when the large size document
is sent via Send To Folder plugin.

- Flow Redirector/Table Replacement filters can be overwritten in multi-thread,
multi-job environment.

- Some wordings are corrected.
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1.5.3.0 |1)

2)

Device Support Changes

GlobalScan NX Serverless/Business Server/Enterprise Server Edition V1.5.3.0

now supports the following devices:

Aficio SP 5200S/Aficio SP 5210SF/Aficio SP 5210SR/
Aficio MP 2352SP/Aficio MP 2852SP/Aficio MP 3352SP

Specification Changes

A "Batch Download Logs" button has been added to the AdminTool's
Maintenance Settings. It is used to download different log types from the
AdminTool and the selected devices in a batch operation.

The default scan size for A4 (Letter) devices has been changed to "8 1/2 x 11

LandScape".

NTLM authentication requests now use standard formatting. Previous versions
used a different formatting that could be authenticated even if the time skew
between GSNX and the authenticating server was great.

Fixed Issues

Fixed: The Send to Email function does not send Notifications.
Fixed: Wide format paper sizes would not be displayed on the Scan Size tab

after updating to V1.5.2.0.

Fixed: Garbage/useless data would be included in imported Profiles. If a single
Profile went though multiple export-import cycles, it could eventually cause

SC997 on synchronization.

Fixed: Send to Folder can fail due to an out of memory error if a non-domain
controller responds to a request when using a NetBIOS user name and the

amount of scan data is large.

1.5.2.0 [ 1) Fixed Issues
Fixed: Activation information is lost if a Remote Desktop Console session is used
to perform an upgrade from GSNX V1.4.4 to GSNX V1.5.

2) Other
When the "Cancel" button is used to cancel a job in the job queue, the cancelled
job is now moved to the error queue.
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1.5.1.0 [1) Device Support Changes
GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.5.1.0
now supports the following device:
Aficio MP 201F/201SPF.

2) Specification Changes

Users can now scan directly from the Metadata input screen.

A new Scan Method, “Mixed Batch,” was added.

Support for PDF/A when using the Send To E-mail's Page Divide function.

LDAP Search results are now sorted.

Support for the UPN (username@FQDN) is now available when using Active
Directory as the authentication method.

Please note that if the UPN's FQDN and the domain stored in the AD
authentication profile do not match, the UPN's domain must be registered as a
trusted domain.

NTLM v2 authentication is now supported for authenticating with a WebDAV
server.

3) Fixed Issues

Fixed: Projects requiring authentication cannot be logged in to on 4-line MFPs, if
the project was searched for by number.

Fixed: E-mail addresses that GSNX failed to deliver to (due to an invalid IP
address for the SMTP server, etc.) are included in the Job Log's "Destination
Address" column.

Fixed: A SFTP connection session remains even after the FTP delivery service
completes delivery.

Fixed: After upgrading GSNX Enterprise Server, only 32 devices remain in the
Device list.

Fixed: Extra authentication information is included in imported profiles.

If the extra information builds up, it could eventually reduce performance when
changing screens on the operation panel or SC997.

4) Other

When more devices are registered in the device list than the current edition
allows, the extra devices must be deleted before synchronization or other device
management actions can be performed.

This only occurs when an overwrite installation, leftover data installation, or
backup data restoration occurs between different editions of GSNX.

GSNX no longer writes data to the SD-Card as a part of log creation.
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1.4.4.0

1) Device Support Changes
GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.4.4.0 now
supports the following devices:

Aficio MP C300/C400/C4501/C5501/C3001/C3501/C2051/C2551/ W2401/W3601
The Aficio MP C300/C400 does have a limitation:

GSNX v1.4.4.0 can only scan A4/Letter landscape documents on the Aficio MP
C300/C400.

2) Specification Changes

It is now possible to select the location where the output of the Metadata
Replacement filter is saved.

SDK application version information and other data are now written to the GSNX
system log when the MFP starts up.

3) Fixed Issues
Fixed: Exported Replacement Tables that contain a comma in the Comparison
Target String are not imported correctly.
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1.4.1.0

Device Support Changes

2) Specification Changes

3) Fixed Issues

GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.4.1.0
now supports the following devices:
» Be-C1

A hardware key can now be used to access the project search function on the
Model Aficio MP 171SPF/LD117SPF/917SPF.

The GlobalScan NX icon is now displayed on the Extended Featues screen.
The Activation Tool can now be used to activate the Kerberos option.

The Kerberos option is now supported for use with GSNX Serverless.
"Passwordless Authentication" (Active Directory and LDAP) has been added as
an authentication method.

A confirmation dialogue now appears when a scan job completes.

Wide format paper sizes have been added to scan settings menu.

"Continue flow without performing replacement" has been added to the "Select
Action when Table Data does not Match" menu.

A log entry is recorded in the Syslog when the metadata replacement filter does
not match.

The tag "JIS" has been added to the "Bx" paper size.(e.g.; B4 JIS)

The dayofweek and generationDate(Local) metadata fields have been added.
The Error Queue now supports batch downloading of error images.

The IP address field of the device list now links to each registered device's Web
Image Monitor.

A Plug-in Information page has been added to the AdminTool.

"Logical Division (Join Automatically)" has been added as an e-mail attachment
Size Divide option.

Support for PDF/A has been added to the PDF Converter.

The user's home folder and email address can now be retrieved from an
authentication server that is not used for the authentication profile.

The total number of entries for the replacement table has been raised from 1000
to 2000.

New fax templates for fax delivery based on day of the week or time are
available for installation with the other project templates.

Fixed: When logging in to the project without a password, delivery fails if scan to
home folder is used.

Fixed: The Operation panel locks as a result of logging out via the logout key
while a dialog box is displayed.

Fixed: LDAP server address search fails if the DN of the login user is required
when attempting email delivery.

Fixed: The Start key turns red and cannot be pressed if the project only contains
Flow Redirect and was restored from a profile created by GSNX v1.3.4.0 or
earlier.

Fixed: The Start key would turn green when the error dialog that appears when
the same password is input as both the user and master passwords for the PDF
conversion filter is closed.
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RTB Reissue

The items in bold italics have been corrected.

Subject: Release Note: GlobalScan NX (Update Module) Prepared by: M. Horikoshi

From: Solution Support Sect., Solution Support Dept.

Classification: |[] Troubleshooting [] Part information ] Action required
[] Mechanical [] Electrical [] Service manual revision
[] Paper path [] Transmit/receive [] Retrofit information
[] Product Safety X Other ( ) X Tier 2

This RTB has been issued to announce the module release information for the
GlobalScan NX.

This module is used for updating the GlobalScan NX SDK application from ver. 1.3.x
using Remote Manager.

Version Program No. Effective Date Availability of RFU
1.5.6.0 D4205271F October 2012 production -
1.5.5.0 D4205271E May 2012 production -
1.5.4.2 D4205271D March 2012 production -
1.5.3.0 D4205271C October 2011 production -
1.5.2.0 D4205271B June 2011 production -
1.4.4.0 D4205271A December 2010 production -
1.4.2.0 D4205271 1st Mass production -

Note: Definition of Availability of RFU via @Remote
“Available”: The firmware can be updated via RFU or SD card.
“Not available”: The firmware can only be updated via SD card.

Version Modified Points or Symptom Corrected

1.5.6.0 | Others:

- The "Cancel” button is now grayed out when performing an update,
overwrite, or leftover data installation.

- GSNX now attempts a retry when fax data reception fails.

Fixed:

- Users may be unable to log in to a Project after a Profile is synchronized to
multiple devices at the same time.

- Creating a subfolder on a Domain-based DFS system causes Send to
Folder delivery to fail.

- GSNX fails to deliver to a Domain-based DFS destination in a network
where the server acting as the Domain controller and the server controlling
the DFS system are different.

- Fax delivery sometimes fails for certain device models.

Update the Java VM to the latest version before installing this update.
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1.5.5.0 | Supported:

GlobalScan NX now supports the following devices:
Aficio MP 301

Aficio MPC 305/DSc530

Aficio MP 6002/7502/9002

Fixed:
The OCR Filter, PDF Converter, Image Convertor consume more of GlobalScan NX's
memory than is necessary (Server Edition).

1.5.4.2 | Supported:

GlobalScan NX Serverless/Business Server/Enterprise Server Edition V1.5.4.2 now
supports the following devices:

Aficio MP C4502 / Aficio MP C5502 / Aficio MP C3002 / Aficio MP C3502 / Aficio MP
4002 / Aficio MP 5002

Others:

- A'Windows Server 2008 R2 AD server is now supported for Active Directory
Authentication. (Serverless Edition Only).

- Send To Email plugin allows to use "Default Sender Address" as sender email
address regardless of the login user's email address.

- Send To Email plugin's email address validation now can be disabled.

- Image Correction Filter's minimum supported resolution is expanded to 80dpi as
inbound FAX sometimes has less than 100dpi resolution.

- "RICOH" logo is added to installer and AdminTool.

Fixed:

- Scan Size setting may not be applied correctly if it is configured in System >
Servie/Filter Settings > Scan Settings.

- Unable to input capital letters as destination email address in Send To Email
plugin.

- OutOfMemory or InsufficientMemory error occurs when the large size document
is sent via Send To Folder plugin.

- Flow Redirector/Table Replacement filters can be overwritten in multi-thread,
multi-job environment.

- Unable to process specific PNG format and image library stopped (Server
Edition Only).

- Saving TIFF image increase the image resolution unexpectedly (Server Edition
Only).

- OCR processing may result in buffer overun (Server Edition Only).

- Some wordings are corrected.

1.5.3.0 [ 1) Device Support Changes

- GlobalScan NX Serverless/Business Server/Enterprise Server Edition V1.5.3.0
now supports the following devices:
Aficio SP 5200S/Aficio SP 5210SF/Aficio SP 5210SR/Aficio MP 2352SP/
Aficio MP 2852SP/Aficio MP 3352SP

2) Specification Changes
- A "Batch Download Logs" button has been added to the AdminTool's
Maintenance Settings. It is used to download different log types from the
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AdminTool and the selected devices in a batch operation.

- The default scan size for A4 (Letter) devices has been changed to "8 1/2 x 11
LandScape".

- NTLM authentication requests now use standard formatting. Previous versions
used a different formatting that could be authenticated even if the time skew
between GSNX and the authenticating server was great.

3) Fixed Issues

- Fixed: The Send to Email function does not send Notifications.

- Fixed: Wide format paper sizes would not be displayed on the Scan Size tab
after updating to V1.5.2.0.

- Fixed: Garbage/useless data would be included in imported Profiles. If a single
Profile went though multiple export-import cycles, it could eventually cause
SC997 on synchronization.

- Fixed: Send to Folder can fail due to an out of memory error if a non-domain
controller responds to a request when using a NetBIOS user name and the
amount of scan data is large.

1.5.2.0 [ 1) Device Support Changes
- GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.5.2.0
now supports the following device:
Aficio MP 201F/201SPF.

2) Specification Changes

- Users can now scan directly from the Metadata input screen.

- A new Scan Method, “Mixed Batch,” was added.

- Support for PDF/A when using the Send To E-mail's Page Divide function.

- LDAP Search results are now sorted.

- Support for the UPN (username@FQDN) is now available when using Active
Directory as the authentication method.

Please note that if the UPN's FQDN and the domain stored in the AD
authentication profile do not match, the UPN's domain must be registered as a
trusted domain.

- NTLM v2 authentication is now supported for authenticating with a WebDAV
server.

3) Fixed Issues

- Fixed: Projects requiring authentication cannot be logged in to on 4-line MFPs, if
the project was searched for by number.

- Fixed: Users could attempt to login to the SDK application during
synchronization. This would always fail, and is no longer possible.

- Fixed: E-mail addresses that GSNX failed to deliver to (due to an invalid IP
address for the SMTP server, etc.) are included in the Job Log's "Destination
Address" column.

- Fixed: A SFTP connection session remains even after the FTP delivery service
completes delivery.

- Fixed: After upgrading GSNX Enterprise Server, only 32 devices remain in the
Device list.

- Fixed: Extra authentication information is included in imported profiles.

- If the extra information builds up, it could eventually reduce performance when
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changing screens on the operation panel or SC997.
- Fixed: Activation information is lost if a Remote Desktop Console session is used
to perform an upgrade from GSNX V1.4.4 to GSNX V1.5.

4) Other

- When more devices are registered in the device list than the current edition
allows, the extra devices must be deleted before synchronization or other device
management actions can be performed.

- This only occurs when an overwrite installation, leftover data installation, or
backup data restoration occurs between different editions of GSNX.

- GSNX no longer writes data to the SD-Card as a part of log creation.

- When the "Cancel" button is used to cancel a job in the job queue, the cancelled
job is now moved to the error queue.

1.4.40 |[1) Device Support Changes
GlobalScan NX Serverless/Business Server/Enterprise Server Editions V1.4.4.0 now
supports the following devices:
- Aficio MP C300/C400/C4501/C5501/C3001/C3501/C2051/C2551/
W2401/W3601
The Aficio MP C300/C400 does have a limitation:
- GSNXv1.4.4.0 can only scan A4/Letter landscape documents on the Aficio
MP C300/C400.

2) Specification Changes

- ltis now possible to select the location where the output of the Metadata
Replacement filter is saved.

- SDK application version information and other data are now written to the GSNX
system log when the MFP starts up.

3) Fixed Issues

Fixed: Exported Replacement Tables that contain a comma in the Comparison
Target String are not imported correctly.

1.4.2.0 | Minor bug correction.
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RTB Reissue

The items in bold italics have been corrected.

Subject: Release Note: GlobalScan NX Prepared by: M.Horikoshi

From: Solution Support Sect., Solution Support Dept.

Classification: |[] Troubleshooting [] Part information ] Action required
[] Mechanical [] Electrical [] Service manual revision
[] Paper path [] Transmit/receive [] Retrofit information
] Product Safety X Other ( ) X Tier 2

This RTB has been issued to announce the module release information for the
GlobalScan NX for RCN.

Version Program No. Effective Date Availability of RFU
1.5.6.0 D4205261E October 2012 production Not available
1.5.5.0 D4205261D May 2012 production Not available
1.5.4.2 D4205261C March 2012 production Not available
1.5.4.0 D4205261B January 2012 production Not available
1.5.3.0 D4205261A October 2011 production Not available
1.5.2.0 D4205261 1st Mass production Not available

Note: Definition of Availability of RFU via @Remote
“Available”: The firmware can be updated via RFU or SD card.
“Not available”: The firmware can only be updated via SD card.

Version Modified Points or Symptom Corrected

1.5.6.0 | Others:

- The "Cancel” button is now grayed out when performing an update,
overwrite, or leftover data installation.

- GSNX now attempts a retry when fax data reception fails.

Fixed:

- Users may be unable to log in to a Project after a Profile is synchronized to
multiple devices at the same time.

- Creating a subfolder on a Domain-based DFS system causes Send to
Folder delivery to fail.

- GSNX fails to deliver to a Domain-based DFS destination in a network
where the server acting as the Domain controller and the server controlling
the DFS system are different.

- Fax delivery sometimes fails for certain device models.

Update the Java VM to the latest version before installing this update.

1.5.5.0 | Supported:

GlobalScan NX now supports the following devices:
Aficio MP 301

Aficio MPC 305/DSc530

Aficio MP 6002/7502/9002

Fixed:
The OCR Filter, PDF Converter, Image Convertor consume more of GlobalScan NX's
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Version Modified Points or Symptom Corrected
memory than is necessary (Server Edition).

1.5.4.2 | Supported:

GlobalScan NX Serverless/Business Server/Enterprise Server Edition V1.5.4.2 now
supports the following devices:

Aficio MP C4502 / Aficio MP C5502 / Aficio MP C3002 / Aficio MP C3502 / Aficio MP
4002 / Aficio MP 5002

1.5.4.0 [ Others:

- A Windows Server 2008 R2 AD server is now supported for Active Directory
Authentication. (Serverless Edition Only).

- Send To Email plugin allows to use "Default Sender Address" as sender email
address regardless of the login user's email address.

- Send To Email plugin's email address validation now can be disabled.

Fixed:

- Scan Size setting may not be applied correctly if it is configured in System >
Servie/Filter Settings > Scan Settings.

- Unable to input capital letters as destination email address in Send To Email
plugin.

- OutOfMemory or InsufficientMemory error occurs when the large size document
is sent via Send To Folder plugin.

- Flow Redirector/Table Replacement filters can be overwritten in multi-thread,
multi-job environment.

- Some wordings are corrected.

1.5.3.0 | 1. Device Support Changes

- GlobalScan NX Serverless/Business Server/Enterprise Server Edition V1.5.3.0
now supports the following devices:
Aficio SP 5200S/Aficio SP 5210SF/Aficio SP 5210SR/Aficio MP 2352SP/Aficio
MP 2852SP/Aficio MP 3352SP

2. Specification Changes

- A "Batch Download Logs" button has been added to the AdminTool's
Maintenance Settings. It is used to download different log types from the
AdminTool and the selected devices in a batch operation.

- NTLM authentication requests now use standard formatting. Previous versions
used a different formatting that could be authenticated even if the time skew
between GSNX and the authenticating server was great.

3. Fixed Issues

- Fixed: The Send to Email function does not send Notifications.

- Fixed: Wide format paper sizes would not be displayed on the Scan Size tab
after updating to V1.5.2.0.

- Fixed: SC997 occurs in a device when It perform the synchronization of the
profile in the environment that performed the import of the profile many times.

- Fixed: Send to Folder can fail due to an out of memory error if a non-domain
controller responds to a request when using a NetBIOS user name and the
amount of scan data is large.
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RTB Reissue

The items in bold italics have been added.

Subject: Release Note: GlobalScan NX (Update Module) Prepared by: M.Horikoshi

From: Solution Support Sect., Solution Support Dept.

Classification: |[] Troubleshooting [] Part information ] Action required
[] Mechanical [] Electrical [] Service manual revision
[] Paper path [] Transmit/receive [] Retrofit information
[] Product Safety X] Other (Firmware) X Tier 2

This RTB has been issued to announce the firmware release information for the
GlobalScan NX (Update Module) for RCN.

Version Program No. Effective Date Availability of RFU
1.5.6.0 D4205281C October 2012 production Not available
1.5.5.0 D4205281B June 2012 production Not available
1.5.4.2 D4205281A March 2012 production Not available
1.5.3.0 D4205281 1st Mass production Not available

Note: Definition of Availability of RFU via @Remote
“Available”: The firmware can be updated via RFU or SD card.
“Not available”: The firmware can only be updated via SD card.

Version Modified Points or Symptom Corrected

1.5.6.0 | Others:

- The "Cancel” button is now grayed out when performing an update,
overwrite, or leftover data installation.

- GSNX now attempts a retry when fax data reception fails.

Fixed:

- Users may be unable to log in to a Project after a Profile is synchronized
to multiple devices at the same time.

- Creating a subfolder on a Domain-based DFS system causes Send to
Folder delivery to fail.

- GSNX fails to deliver to a Domain-based DFS destination in a network
where the server acting as the Domain controller and the server
controlling the DFS system are different.

- Fax delivery sometimes fails for certain device models.

Update the Java VM to the latest version before installing this update.
1.5.5.0 | Supported:

GlobalScan NX now supports the following devices:

Aficio MP 301

Aficio MPC 305/DSc530

Aficio MP 6002/7502/9002

Fixed:
The OCR Filter, PDF Converter, Image Convertor consume more of GlobalScan
NX's memory than is necessary (Server Edition).
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Version Modified Points or Symptom Corrected

1.5.4.2 | Supported:
GlobalScan NX Serverless/Business Server/Enterprise Server Edition V1.5.4.2
now supports the following devices:
Aficio MP C4502 / Aficio MP C5502 / Aficio MP C3002 / Aficio MP C3502 / Aficio
MP 4002 / Aficio MP 5002

Others:

- A Windows Server 2008 R2 AD server is now supported for Active Directory
Authentication. (Serverless Edition Only).

- Send To Email plugin allows to use "Default Sender Address" as sender email
address regardless of the login user's email address.

- Send To Email plugin's email address validation now can be disabled.

- Image Correction Filter's minimum supported resolution is expanded to 80dpi
as inbound FAX sometimes has less than 100dpi resolution.

- "RICOH" logo is added to installer and AdminTool.

Fixed:

- Scan Size setting may not be applied correctly if it is configured in System >
Servie/Filter Settings > Scan Settings.

- Unable to input capital letters as destination email address in Send To Email
plugin.

- OutOfMemory or InsufficientMemory error occurs when the large size
document is sent via Send To Folder plugin.

- Flow Redirector/Table Replacement filters can be overwritten in multi-thread,
multi-job environment.

- Unable to process specific PNG format and image library stopped (Server
Edition Only).

- Saving TIFF image increase the image resolution unexpectedly (Server Edition
Only).

- OCR processing may result in buffer overun (Server Edition Only).

- Some wordings are corrected.

1.5.3.0 [ 1st Mass production
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